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“Psychosis, although at times subtle, was pervasive across
psychological tests and testing situations. When stressors are
minimal this patient may withdraw into his dream world putting his
resentments aside and attempting to convey an air of well-being. If
these efforts give way under the slightest pressure, regulating his
angry dismay, stirring up his dejection and his feelings of being
misunderstood and mistreated, leading him to act out momentarily
and then to retreat again into fantasy or despondency. Data are
significant for recurrent periods of more psychotic functioning.”
- Jane DeSmith PhD, Rochester Regional Forensic Unit As quoted on page 17 of the report of Igor Kashtan MD dated 2003-09-11.

Fancy, that! “Got bugs?” †
- AnneRose Blayk f/k/a “Kevin Eric Saunders a/k/a bonze blayk” - COMETMONGER
† - “DEAR SIR OR MADAM… THAT IS NOT A BUG: IT IS A CREATURE FEATURE!”

Here follow the “Release Notes” of a complex delusional system elaborated by one “bonze blayk” in
the form of a ‘computer program’ as part of his, her, or its dream world; note the extraordinary
circumstantiality therein and fixation on minor issues, which he, she, or it has previously expressed
in the statement “God is in the details,” and bizarre obsession with “Bug fixes,” indicating a need for
treatment oriented towards addressing formication induced by unremitting abuse of Substance-D. The Penultimate Psychiatrist

A1. dataComet & dataComet-Secure X Release Notes
________________________________________________________________
dataComet documentation. (Rev. 7/23/2012)
Copyright 2010 databeast, Inc. All Rights Reserved.
This document has information on (select and use "Find..." to go to the section):
Known Bugs in the current version
Release Notes:
dataComet-X for OS X:
10.2.2
10.2.1r2
10.2.1r1
10.2.0
10.2.0b3

10.2.1
10.2.0b2

10.2.1b2
10.2.0b1

dataComet-Secure X for OS X:
10.2.2
10.2.1r2
10.2.1r1
10.2.1b2
10.2.0
10.2.0b3
10.2.0b2

10.2.1b1
10.2.0b1

10.2.1b1

A version of dataComet for OS X without encryption support built in is being made available as "dataComet X". dataComet,
unlike dataComet-Secure, can be redistributed freely as shareware without complying with Federal Export controls which apply to
dataComet-Secure. In other respects dataComet is identical to dataComet-Secure for Mac OS X.
___________________________________________________
Known Bugs in the current version
___________________________________________________
* dataComet fonts do not work with the OS X "Keyboard Viewer" Input menu option.
"Character Viewer" palette.)
* NOT bugs: The Console application reports errors when dataComet is launched
>annexNumber != kInvalidAnnexNumber (0)", and the Font Book application lists a
usability" when the Comet bitmap fonts are validated, stating "2 serious errors
reason OS X since Leopard has been reporting errors with bitmap fonts which are
these are the only problems reported, and the fonts continue to work fine.

(Under Snow Leopard they now work with the

stating "com.apple.fontd[114] FODBCheck: foRec"Problems" with "'FOND' font association
were found. Do not use these fonts." For some
not embedded along with TrueType fonts; however,

___________________________________________________
10.2.2 -Secure
6/25/12
10.2.2 -X
___________________________________________________
Features:
* Added Code Signing security feature for dataComet and dataComet-Secure releases so that Mountain Lion's new GateKeeper system
will recognize them as applications by an identified developer.
___________________________________________________
10.2.1r2 -Secure
1/17/12
10.2.1r2 -X
___________________________________________________
Bug Fixes:
* Fixed a bug which caused dataComet to crash when "Scrollback Buffering" was turned on and the scrollback buffer was cleared,
or the emulator window was resized.
* dataComet should no longer crash if the dataComet "Preferences..." dialog panel is opened when no other windows are open.
* The estimate of the current speed of file transfers in the File Transfer Progress dialog is now more accurate.
___________________________________________________
10.2.1r1 -Secure
8/5/10
10.2.1r1 -X
___________________________________________________

Bug Fixes:
* MAJOR BUG FIX: Creating a new terminal session will no longer cause dataComet to crash after the session connection is
completed. This was occurring when the session had the Control menu Translation option set by default; the translation table
resource file was being closed, resulting in the disappearance of the table from memory and failure when the emulator attempted
to read from the translation table.
* SSH2 connections will now open a session cleanly the first time through when the login name has not already been saved as the
session's Username (which appears in the "Configure Terminal Session..." dialog). A preliminary dialog for entering the login
user name before initiating SSH user authorization negotiations has been added to fix this problem.
* The Command-R key combination once again executes the Window menu "Re-open Session" command, as in earlier versions of
dataComet.
* The font width setting in the "Control" menu "Width" menu is now ignored when printing.
* Horizontal scrolling in edit windows using the mouse has been fixed so that no scrolling is performed when text in the edit
window is displayed as wrapped text. This avoids a condition where the text could be scrolled to the right, but could not
scrolled back to the left margin, requiring the window to be resized to display the text correctly.
* The '¥" mark in the Window menu window list indicating that a terminal session is open is now set correctly on a consistent
basis.
* The File menu "Page Eject" command will now force printing and reset VT100 print streaming mode if a VT100 print stream has
not received a VT100 "End print stream" control sequence from the host.
___________________________________________________
10.2.1 -Secure
7/20/10
10.2.1 -X
___________________________________________________
Bug Fixes:
* Backspace now works with Undo, but does not set the Clipboard, so Paste will paste the text in the Clipboard from the previous
Copy or Cut command.
* The ".txt" suffix is now added automatically to text documents when they are first saved; performing a "Save as..." for an
existing document with ".txt" added will delete the old edit document if the name is otherwise the same.
* dataComet edit windows now have their window resources and dataComet 'usro' Finder -> dataComet link set promptly when they
are first saved.
* dataComet "session.edit" windows are now brought to the front when the document is opened from the Finder and the document is
already open, rather than opening a new window.
___________________________________________________
10.2.1b2 -Secure
7/6/10
10.2.1b2 -X
___________________________________________________
Features:
* Emulator window drawing routines have been modified so display of text files transmitted from the host will be processed 2-3X
faster, with screen updates of the current page of large files occurring every second rather than every two seconds.
* Added support for Keyboard Interactive mode in SSH, along with a dialog to perform the Challenge/Response interaction. SSH
sessions are configured by default to use the session password as the response, and skip the dialog when there is only one
Challenge from the host; this feature can be disabled using the "Use session password automatically" checkbox in the "Configure
SSH" dialog (which is reached from the Configure Terminal Session dialog).
* Added a Cancel Macro dialog to display a string and query the user whether she wishes to cancel the current macro, along with
a "!QM" macro command to post the dialog. The "!p?" RSLT_TESTMACROFAIL macro command can now also have an optional string
appended to it (ending with "!\000"), in which case failure will bring up the Cancel Macro dialog with the string used as a
prompt.
* Added more macro failure conditions which can be tested using the "!p?" macro command; these are documented in the dataComet
Help document "4.1. macrocodes.h" as "sets RSLT_TESTMACROFAIL" conditions.
Bug Fixes:
* Define Macro dialog:

- Button, Menu, and Connection macros are now updated reliably when the "Set" button is pressed; previously this worked
correctly only once without closing and reopening the dialog.
- The correct button name and macro contents are displayed when sessions are switched using the popup menu.
- The text field in the dialog now displays "\000" for NUL characters in the macro, since only Comet Fonts contain a
corresponding glyph for the "^@" NUL character.
* Macros:
- The "!L\nnn" loop command has been fixed so the correct number of loops are performed; existing macros containing loop
commands may need to be modified to accomodate this change.
- Nested "!L\nnn" loops now work correctly.
- The "!Z\nnnSTRING\000" wait for string command now works when embedded in loops.
* The text cursor or selection range in the frontmost edit window should now be displayed (or hidden) correctly when the
"Find..." dialog is being used when switching windows.
___________________________________________________
10.2.1b1 -Secure
5/24/10
10.2.1b1 -X
___________________________________________________
Features:
* dataComet now draws selected fonts with antialiasing disabled so bitmap fonts can be displayed. This feature is implemented
using a list of fonts and sizes to be drawn with antialiasing disabled. This provides a huge improvement over earlier
implementations of this feature in dataComet. (In the Beta implementation of this feature, this list is saved in a text
document, "xFont List", which can be edited by the user by selecting the "View Font List" button in the Preferences Global
Preferences panel.)
* dataComet now checks the databeast.com website and presents an alert to inform you when a new version is available. You can
disable this feature in the dataComet "Preferences" "Global" panel. (This feature can also be completely disabled for site
distributions by placing a "GetVersionDisabled" file in the dataComet application bundle's "Resources" folder.)
* Session and text document windows now have a popup menu at the top of the vertical scroll bar which contains a sorted list of
open documents to make switching windows easier.
* Cloned, multiply launched, new Shell, and untitled windows now have a number appended to the Window title to help
differentiate between these windows. When the configuration of a numbered Session window is saved, the document name in the
"Save Configuration" dialog defaults to the original Session document name, so saving a numbered Session window will, by default,
update the source Session document.
* The dataComet application, session document, and text document icons have been updated, along with the splash screen.
Session Enhancements:
* You can now set Telnet sessions so Telnet protocol interpretation is disabled, enabling dataComet to conduct raw TCP sessions.
Telnet menu options selecting "7-bit characters"/"8-bit characters", "Send after return"/"Send characters promptly", "Local
echo"/"Remote echo" are now saved in the session configuration and applied when a Telnet session is in raw mode.
* dataComet-Secure now includes support for sending stored passwords over unencrypted Telnet and Serial sessions, so you can log
in to sessions automatically by incorporating the "!tu" "Send username" and "!tp" "Send password" macros in a Connection Macro.
This "Macro" password is transmitted once, and only once, per session. The "Configure Terminal Session" now allows you to enter
a password for these types of connections in the "Password" field; this type of password, however, is saved in a location
separate from the password for the more secure session types.
* An option to "Prompt before closing if session open" has been added to the Preferences "Session" panel, so one can disable the
alert requesting an OK before closing a session window when a session is still open.
* The Serial menu now has a "Local Echo" item to allow you to enable local echo on serial sessions.
* Mouse single-clicks in an IBM 3270 session window now move the cursor immediately.
Menu enhancements:
* The "Control" -> "Size" submenu now includes "Larger" and "Smaller" commands to change the font size; these commands have been
assigned to the Command-'+' and Command-'=' keys.
* Selecting a window from the "Window" menu for a Session document now brings up both the emulator and its .edit window in their
prior order, and no longer alternates between the emulator and .edit windows; pressing the Control key while selecting a window
brings only the emulator window forward; pressing the Option key while selecting a window brings only the .edit window forward.
Menu key command changes:
- Command-',' now brings up the dataComet "Preferences" dialog rather than executing the "Match Brackets" command.

- Command-''' and Command-'"' execute the "Match Brackets" command.
a command-key equivalent.)

(The "Scrollback Buffering" command no longer has

- Command-'E' now executes the Mac standard "Use Selection for Find" command.
to find the string.

You can then use "Find Again..." (Command-'G')

- Command-';' now executes the "Toggle .edit Window" command.
- Command-':' now executes the "Go to Line..." command.
- Command-'+' and Command-'=' make the screen font size larger or smaller.
- Command-'\' executes the Zoom command.
- Command-'|' executes the Window menu "Close Session" command.
- Command-Option-'/' is now used to execute the Cursor menu "Add Returns" command, since Apple now uses it for a default
Shortcut.
Dialog Enhancements:
* The dataComet "Preferences" panels now contain a popup menu with a list of open documents, allowing you to view session
configurations for different sessions easily. The dataComet "Preferences" dialog now saves its position so the next time you
open it, it will appear in the same place on the screen.
* The dataComet "Preferences" "Printing" panel now has popup menus allowing you to view and select the font and font size
settings for both onscreen display and printing. The Control menu "Font" and "Size" submenus now set only the on-screen font and
its size by default; you can set the Print font and size from these menus by holding down the Option key.
* A Help dialog has been added to improve help for modal dialogs, such as the "Configure Terminal Session" dialog; ControlClicking on an item in a modal configuration dialog will open the Help dialog and display the information for that item.
* A number of improvements were made to the "Define Macros..." dialog:
- A popup menu containing a list of open documents now allows you to view settings for other documents easily.
- Pressing the "Set" button now leaves the selected macro displayed to make editing of macros in other documents easier.
select a new key for remapping, one must now Press the "Cancel" button.

To

- A "+ Button" button has been added to the macro dialog to make it easy to add a new button to an emulator's session
document.
- The "Use Command Font" checkbox may now be toggled when a macro is displayed, so it's now easier to switch between the
Command Font, with its graphic renditions of PF keys, and the font selected for displaying the document.
- An "Alt-key" checkbox has been added to the dialog so Alt keys can be set without holding down the mouse button. Toggling
the checkbox will refresh the key display so the macro can be viewed easily viewed in both the standard and Alt-key states.
Macro Enhancements:
* The area which displays macro buttons at the top of an emulator window now resizes dynamically depending on the number of
buttons, and the maximum number of buttons per window has been increased to 256 from 24.
* A new macro command, '!""string\000' has been added so that comments can be incorporated in macros.
command is ignored when macros are executed.

The string after this

* Macros have been added to simplify opening files which are not in one of dataComet's default open folders:
- "!Fv":
commands.

"!Fvvolumname\000" sets the default folder to use for files subsequently opened with the "!FN" and "!F¢" macro

- "!FN":

"!FNfilename\000" opens a file in the currect macro default folder.

- "!Fu":

Sets the default directory for opening user macro commands to the user's home directory.

- "!FUfilepath":

Opens "filepath" in the user's home directory.

* Added macros for support of global variables:
- "!$\nnn": Put global string numbered 'nnn'
- "!G\nnn": "Get" variable numbered 'nnn' from following
macro string terminated by '\000'
- "!g\nnn": "Get" variable numbered 'nnn' from selection

* Macros have been added to facilitate loading and transmitting files with data in a CSV format.
- "!F¢":

These commands are:

"!F¢filename\000" loads data from a file with fields separated by a delimiter into an array of 255 strings.

- "!¢\nnn" sends the string corresponding to the number to the host.
- "!,\nnn" sets the field delimiter to a value other than the default value of ','.

(Note that the Tab character is '\009'.)

* Other macros have been added to support CSV data file processing:
-

"!p+":
"!p-":
"!p1":
"!p$":
"!pe":

- "!p.":
- "!p?":

- "!p/":

select next row of CSV values
select previous row of CSV values
select first row of CSV values
select last row of CSV values
test used after "!p+": if end of values, cancel
enclosing loop
test used after "!p+": if end of values, cancel
all remaining macros
tests for error condition in macro command execution
and aborts macros for the session if an error
occurred; automatically reset when tested.
resets error condition code.

Bug Fixes:
* CRITICAL: Remedied a failure to catch SIGPIPE signals when a terminal session was not closed properly from the host end,
which could cause dataComet to terminate abruptly. (Note that dataComet sessions do not process data from the host when you have
scrolled back in the session's scrollback buffer, so connections may be terminated if the host sends data and requires an
acknowledgment while you are scrolled back. This deficiency will be remedied in a future release.)
* Fixed a problem where key macro keycodes were being translated improperly when interpreted on PowerPC vs. Intel machines, so
that key macros created on one platform could not be used on the other platform. Keycodes will now be interpreted correctly
regardless of the type of machine on which they were created; 10.2.0 users must download 10.2.1b1 for this fix to work properly.
* The size of the button macro name field in the emulator structure has been increased from 63 to 255 so entering a button name
longer than 63 characters in the "Rename button" dialog will no longer cause a crash.
Connection fixes:
* More informative error notices have been added to assist in the interpretation of SSL connection errors.
* Connection Macros are now executed only once for Shell sessions; they had been executing twice.
* Telnet linemode ("Send after Return" in the Telnet menu) now works correctly.
* Session connections made through TCP (SSH, Telnet, Telnet/SSL) are now deemed to be open as soon as a receive call returns
data; this was highly unlikely to cause a problem, but avoids a situation where an attempt to send data to the host might fail.
* Cancelling a Page Setup print-format dialog triggered by host-driven print streaming (VT100) will now cancel printing the
datastream rather than resulting in repeated Page Setup dialogs.
Window handling fixes:
* The emulator screen position is now saved correctly when the session document is closed; in 10.2.0, the position was only
saved if the window had been zoomed.
* A zoomed emulator window will now appear on the same monitor when more than one monitor is in use.
* Command-Clicking on a document window title now brings up the standard MacOS file path popup menu, allowing you to view the
file path and open folders in the Finder easily.
* The Window menu "Next" command (option-tab) now proceeds to the next open window rather than stopping the cycle if a Session
window has a closed connection.
* The appearance of emulator windows has been improved. The packet counters and timer are now greyed out when the session is
closed, and the Rows and Columns fields at the bottom of the emulator screen now have more area allocated to them.
Dialog fixes:
* Dialogs have been fixed so the text cursor appears when the curosr is over the active text field.
* The appearance and functionality of the "Find" dialog has been improved. The "Backwards" checkbox has been replaced by a
"Previous" button. The "Replace" command now works correctly when the "Replace" text is empty.

* The "Define Macros..." dialog now always displays the ASCII character zero (NUL), which is used in dataComet macros to
terminate strings, as '\000' rather than the Comet Fonts "^A" character to avoid confusion.
* The "Configure Terminal Session" dialog has been improved so that tabbing to the next field works in a sensible fashion, and
clicking on a text field which does not apply to the current connection type produces a brief popup message rather than an
annoying alert -- and now it's not possible to enter text in that field.
* The default session type for a "New" session is now Telnet (or SSH for dataComet-Secure) rather than a "Shell" session.
* Entering an empty address in the "Configure Terminal Session" "Connect to:" field now works correctly to connect to the
machine's own IP address.
* The File Transfer Progress dialog now displays byte counts with commas.
* Fixed the File Transfer Progress dialog so the transfer counts are only updated once a second; this yields a substantial
improvement (~80%) in file transfer performance when using ZModem.
* IND$FILE IBM file transfers now display an update on the transmitted file length in the emulator prompt area.
Edit window fixes:
* Several problems with edit windows have been fixed; extra lines should no longer appear in the window when text is pasted into
the window.
* dataComet's edit windows now interpret linefeed characters in files so they display correctly, and saves them back to the file
as linefeeds. Edit windows will now reliably load up to the maximum 32,767 character limit, rather than failing to load the last
2,000 characters of a file which is over 30,000 characters in length.
* Saving a new Session configuration now always creates a new .edit companion text document, so a "Save text" command will
succeed when the session document is reopened, even when the .edit document was not saved the first time around.
* Changing the font in edit windows now takes effect immediately, rather than after the font size is changed.
* The '<<' and '>>' "Shift Text" buttons at the bottom left corner of edit windows now repeat when they're held down.
Menu fixes:
* Saving a new session document to the global sessions folder now updates the Sessions submenu.
* Submenus have been fixed so they display more rapidly when you move the cursor over them to select an item from them.
* The 3270/5250 menus no longer shift position when the 5250 menu is toggled on and off in the 3270 preferences panel.
Macros menu now always appears before the Window menu.

The

* Window Minimize and Maximize events are now handled better; the window's menu item in the Window menu is marked to show the
window has been Minimized, and you can expand the window by selecting the item.
File transfer fixes:
* SCP/RCP file transfers are now enabled in dataComet X, providing an alternative to using ZModem. SCP transfers in dataComet X
are not encrypted (note that the "scp" file transfer protocol is the same as UNIX's "rcp" with a security layer wrapped around
it.) Also, the SCP file transfer dialog no longer automatically brings up the Select File dialog when it's selected from the
menu to perform an upload.
Printing fixes:
* Emulator screen printing: color banding which appeared when printing an emulator screen in color has been improved, so it
should not appear unless a font is being drawn in double-wide/double-high modes (VT100). Also, the emulator cursor position may
have appeared in screens printed in a very small size; this has also been fixed.

___________________________________________________
10.2.0 -Secure
2/5/10
10.2.0 -X
___________________________________________________
Bug Fixes:
* Modified mouse-click processing so Right-Click will be handled as a Control-Click. Control-Clicking in emulator windows no
longer adds a Return (or Enter) after the selection is pasted; macros using the "!AM" command will need to be modified to add a
Return after the "!AM" command.

* Modified dataComet's handling of the IBM 3270 Read Modified All command when a Select AID is processed so a mouse ControlClick on a Pen-Detect field will work correctly.
* Modified serial device name handling to use "cu" device names rather than "tty" device names so devices supported by the
latest Keyspan drivers appear in the pop-up list of serial devices.
___________________________________________________
10.2.0b3 -Secure
10/5/09
10.2.0b3 -X
___________________________________________________
Bug Fixes:
* Fixed problem with text windows which caused spurious line returns to be added when pasting text.
Features:
* Zooming or resizing an emulator window now changes the font size so it fills the new screen area.
* Interpretation of Brown TN3270 documents has been enhanced so that most parameters are handled correctly.
___________________________________________________
10.2.0b2 -Secure
9/14/09
10.2.0b2 -X
___________________________________________________
Bug Fixes:
* Modified handling of demo time calculations.
___________________________________________________
10.2.0b1 -Secure
9/10/09
10.2.0b1 -X
___________________________________________________
Features:
* The applications are now compiled as Universal Binaries for native support on both Intel and PowerPC architectures.
sessions are significantly faster on Intel machines.

Shell

* The Comet fonts are now embedded in the application so graphics characters will display correctly even when the fonts have not
been copied into the /Library/Fonts folder.
* The "Configure Session" dialog now includes a separate field for entering the port to use when connecting to a host address.
Bug Fixes:
* Native Intel support avoids triggering a bug which apparently affects all PowerPC binaries running under the Rosetta
translator, where a keystroke may intermittently cause the Window Server to crash, placing the user back at the Login screen.
(The crash will appear in the Console logs as occurring when "UCKeyTranslate" is called.)
* Opening a Kerberos Telnet connection no longer causes dataComet-Secure to crash under Snow Leopard.
* SSH connections now prompt the user for a password after a login failure when a Master Password has been entered incorrectly
or the password set in a "Session Configuration" dialog is incorrect.
* SSH2 connections should now handle password change requests correctly.
* The cursor no longer blanks out during SCP file transfers.
* The Comet fonts have been modified so the bold "D" character renders correctly under Snow Leopard.
________________________________________________________________

A1.1 dataComet & dataComet-Secure X Release Notes
________________________________________________________________
dataComet documentation. (Rev. 2/6/10)
Copyright 1995, 2010 databeast, Inc. All Rights Reserved.
This document has information on (select and use "Find..." to go to
the section):
Known Bugs in the current version
Release Notes:
dataComet-X for OS X:
10.1.1
10.0.5

10.0.6
10.0.4

10.0.3

10.0.2

dataComet-Secure X for OS X:
10.1.1
10.0.3
10.0.0b4

10.1.0
10.0.2
10.0.0b3

10.0.6
10.0.1
10.0.0b2

10.0.5
10.0.0
10.0.0b1

10.0.4

___________________________________________________
10.1.1 -Secure
6/21/08
10.1.1 -X
___________________________________________________
Bug Fixes:
* Dramatically improved the screen drawing speed when text antialiasing is in effect. Also fixed a bug where antialiasing was
not correctly initialized; if a session had not been opened in which anti-aliasing was NOT in effect, the font for a session with
antialiasing would not be imaged correctly, resulting in an ugly appearance.
* Fixed a bug in the SSH Configuration "Keys..." dialog which would cause the application to hang if there was a previously
selected Key file which was no longer present.
* Reverted to requiring holding down the Option key to resize the emulator rows/columns size to avoid distorting displays for
applications which can't handle resize operations.
___________________________________________________
10.1.0 -Secure
6/21/08
___________________________________________________
Features:
* Added support for Telnet/TN3270 SSL/TLS secure connections.
___________________________________________________
10.0.6 -Secure
3/31/08
10.0.6 -X
___________________________________________________
Bug Fixes:
* Fixed a VT100 bug which sometimes manifested itself in the OpenVMS EVE editor, occasionally causing "Command" to appear in a
text area when the DO key was pressed and the SPLIT WINDOW command was in effect.
* Fixed VT100 stream printing so Tabs are expanded.
* Fixed cursor selection in emulator windows so selections are offset properly; 10.0.5 introduced a bug which shifted the start
of the selection range.
___________________________________________________
10.0.5 -Secure
10.0.5 -X

3/1/08

___________________________________________________
Bug Fixes:
* Fixed a bug which prevented the macro buttons from working under OS X 10.5 (Leopard).
Features:
* The macro buttons can now be displayed or hidden independently of the prompt area of the emulator screen (using the "Views"
Preferences panel).
___________________________________________________
10.0.4 -Secure
2/19/08
10.0.4 -X
___________________________________________________
Features:
* Support for anti-aliasing has been added; by default the "Global" Preferences panel has anti-aliasing enabled for all windows
with the font size set to a size greater than 12 points.
* Shell session performance has been enhanced.
* Added "Hide all session .edit windows" option in the "Global" Preferences panel to enable users who don't wish to use .edit
windows to hide them on a global basis.
* Emulator windows are now resized without holding down the Option key, and the modeless configuration dialogs are now promptly
updated to reflect the new window size.
* The "Control Font" and the "Define Macro..." dialog font size is now set at 12 points to improve legibility on high-density
displays.
* Added a "Require session close from host" configuration option in the "Session" Preferences panel so user can't close a
session without first closing the session on the host.
* Emulator windows now hide the macro buttons if the "Views" Preferences panel option "Show buttons at top of window" is off.
* Added an "Add Macro Button..." menu item to make adding macros to emulator windows more intuitive.
* The default TEXT and BIN creators are now '????' rather than '3278' so TextEdit (or other user selected editor) opens
documents.
* dataComet and dataComet-Secure are now built using Apple's Xcode development system.
Bug Fixes:
* Fixed a bug in display handling code which could cause crashes.
* Fixed vulnerabilities identified in SSH1 RSA encryption and SSH2 which could allow Man-In-The-Middle attacks.
* Fixed several SCP file transfer bugs:
- SCP uploads over SSH2 connections no longer cause a crash when the file is larger than 120K.
- SCP uploads of large files over encrypted Kerberos connections no longer suffer from file corruption due to repeated
encryption of the same block of data.
- SCP now works correctly when uploading a text file with line Wrap enabled.
- SCP now works over Shell connections to remote hosts using OS X's built-in SSH client.
* Enabled Control-C as interrupt character for Shell sessions.
* Fixed URL handling so "telnet:" and "tn3270:" URLs open a Telnet session and an "ssh:" URL opens an SSH session. To help
enable AppleScript control of sessions, URL sessions no longer present "Save session configuration" dialogs when they are closed.
* Removed alert that was presented on execution of "Connection" macro for Shell.
* Fixed a bug which limited pastes imported from other applications to 32K.
* Enabled editing and execution of macro buttons when connection is closed.
* The "Option is Meta Key" option in the "VT100" Preferences panel now works correctly when the "dataComet Keyboard" is

installed.
* "Views" show packet counter options now work interactively.
* Fixed problems with VT100 screen display areas appearing inverted when a variable-width font was selected and color mapping
was off.
* Fixed bugs in VT100 screen display when "Background Color Erase" mode was selected when characters were deleted or inserted
and color mapping was off.
* The "Word Count" window now displays the correct value for the words and lines in a selection.
* The user beep sound now plays when emwindow is front window.
* Applications can now be selected when the "TEXT App" and "BIN App" buttons are pressed in the "Transfer" Preferences panel.
* File transfer extensions such as ".txt" are no longer added to file names when they are already present in the file name.
* Fixed the "TEXT suffix" field in the "Transfer" Preferences panel so it is blanked correctly when it has not been entered (it
was not being blanked when switching to a session for which it had been entered and then back to a session for which it has not
been entered).
* Printing text with characters from extended character sets in a text window no longer results in wrong characters appearing
due to unnecessary character translation.
* Fixed position of page number so it is centered correctly when printing.
* The "Host Name" menu item in Telnet & SSH menus is now the host name rather than window name.
* Fixed "Save Text as..." dialog so new session.edit window saved in Sessions folder by default.
* Selecting a minimized dataComet document now activates the window.
* The top window is now re-activated correctly after "Replace" option used when "Save configuration..." dialog is executed.
* A new Shell document now comes up with window size and print font size set to the size selected for the "Comet Default"
document.
* The IBM 3270 "Attn" command now sends a Telnet "Break" command rather than a Telnet "Interrupt" command.
* Changed IND$FILE file transfer dialogs so '.' is not translated into '¥' when download host file names are converted to
Macintosh file names. Fixed the IND$FILE file transfer dialog so it no longer automatically sets the filename when a mouse click
is used to select the file name text field (tabbing into the file name field still sets the file name automatically).
* File transfer no longer aborts a file launch when "AutoLaunch" is set and the original file creator cannot be found, since
Launch Services can launch alternate applications without the original file creator application being present.
* Fixes to the "Configure Terminal Session" dialog:
- Switching between SSH & Telnet connections now works without closing the emulator window.
- An alert is posted immediately when when attempting to change Session bype while connected.
- Shell reconfiguration can be performed while connected.
- You can now reconfigure open Shell sessions without getting an error message.
- The "Telnet Configuration..." dialog now sets Authentication and Encryption checkboxes correctly when it is brought up.
* Fixes to the "Define Macro..." dialog:
- Fixed a bug which could leave menu items disabled when a new text document was opened while the "Define Macro..." dialog was
active.
- Fixed the "Define Macro..." dialog so clicking twice on the menu bar dismisses menu rather the resulting in additional menu
drop-down display.
- Macro dialogs were not handling Minimize properly; now they won't minimize when a macro is selected.
- Changed "Show all" macro text display so user not prompted to save dumped macros when closing window.
- Menus are no longer disabled after cancelling Save for new text window when in Macro dialog.
___________________________________________________

10.0.3 -Secure
10/5/04
10.0.3 -X
___________________________________________________
Bug Fixes:
* Fixed a bug occurring with CopyPaste where a "v" would appear in the emulator window when attempting to execute a Paste
command.
* The macro buttons at the top of the emulator screen are now rearranged when the window size is changed so they wrap at the
right edge of the window.
* All files are now enabled in the Open File dialogs used by the "Open...", "Type file name at cursor" and Edit menu "Append
file to .edit window" menu commands and the Transfer menu "Text App", "Bin App", and "Bin Type" buttons. You can now set the
Transfer dialog "Text App", "Bin App", and "Bin Type" file creator and types by entering text manually. (Applications are not
enabled in the Open File dialog, which makes it more difficult to use the Transfer dialog file type/creator buttons; entering the
types manually may also be necessary since under OS X some applications don't set the Macintosh file type or creator when they
create files.)
* The emulator screen clipping is now set correctly when the emulator window is smaller than the size of the emulator area; this
bug would cause the vertical scrollbar to be overdrawn.
* 9, 12, and 16 are now underlined in the "Size" menu to highlight the available bitmap font sizes supplied with dataComet;
these may give you more readable text than TrueType fonts at these sizes.
* Fixed a bug which caused IND$FILE configuration settings, e.g., TSO Host transfer type, to be ignored.
___________________________________________________
10.0.2 -Secure
3/9/04
10.0.2 -X
___________________________________________________
Features:
* Beta versions of TrueType fonts are included in this distribution to support printing of the special character sets under Mac
OS X in addition to allowing larger font sizes in emulator displays. (The old Comet-fonts, which are currently implemented as
bitmap fonts ('NFNT' resources), unfortunately cannot be printed under Mac OS X; pages containing these characters would fail to
print.)
Bug Fixes:
* The Window menu "Bring All to Front" can now be recorded in a macro; likewise the "Quit" command will be recorded and executed
correctly in macros.
* Fixed the function-key handling code so that the PowerBook "fn" function key will produce Shift-Function PF keys.
(Unfortunately Apple's latest updates do not support detection of the Option and Control keys when used with the "fn" key.)
* Fixed a bug which could cause pasting over 16K of text into an emulator window to hang a session.
* Fixed the IBM menu so the IBM Select Cursor menu item will work when it is selected.
* When 8-bit control sequences are selected in the VT100/VT220 emulator, sending CSI[ (0x9b-[) will now work even though the
additional '[' is redundant.
* Fixed ZModem transfers so that the host flag to convert newlines to the native host newline is set when a file being uploaded
is not a binary file (according to the flags set in Internet Config). This should fix problems uploading text files to VMS
hosts.
"Configure Terminal Session" fixes:
* If the Control menu "Lock" item is disabled (for kiosk applications) or the Master Password dialog is cancelled the password
entered in the "Configure Terminal Session" will now work as expected. It will NOT be stored in the session configuration, but
will be used for the first login attempt for an SSH or Kerberos session.
* Fixed the "Configure Terminal Session" dialog so that if you have your Global configuration set to open it on launch, and then
change the Host Address field, the modified address will be used.
* Fixed so leaving the hostname empty will yield your own machine's IP address so it will open a session to itself.
in Classic dataComet but was failing under OS X.
___________________________________________________

This worked

10.0.1 -Secure
4/21/03
___________________________________________________
PLEASE UPGRADE TO THIS VERSION IF YOU ARE USING dataComet-Secure 10.0.0!
This version improves handling of several SSH security related problems!
Features:
* Added support for mouse wheel events; holding down the Option key while wheeling will scroll by pages.
* The "Comet Default" document now appears first in the list of documents in the File->Sessions submenu to make it easier to
open and modify the default session configuration. (This is especially useful for defining the default session document buttons
and macros which will appear in a New Shell.)
* Added support for 16-color colormaps for VT100 series emulators ("Use 16 colors" in the "Color" Preferences pane).
* The option "VT100-wrap (wrap at column 81)" has been added to the "VT100" preferences panel to allow you to disable the VT100
line-feed glitch.
* The "dataComet Keyboard.rsrc" has been added to the distribution to allow elimination of dead-key remapping (works only with
OS X 10.2 or later). Also, when the "Option is Meta Key" option is selected in the "VT100" Preferences Pane, the keymapping now
works in a more intuitive way (Option == Meta, Shift-Option == Shift-Meta, Control-Option == Meta-Control).
* Added new dataComet Launch macro features to improve kiosk functionality under OS X; see Help document "A4. dataComet Kiosk
Configuration". Using the "!\000\196" macro to disable the dataComet-Secure menu "Preferences..." command now works correctly;
disabling the "New -> Shell" submenu item will disable local Shell connections.
Bug Fixes:
* Addressed problems related to the CERT¨ Advisory CA-2002-36 "Multiple Vulnerabilities in SSH Implementations" (described at
<http://www.cert.org/advisories/CA-2002-36.html> and <http://www.kb.cert.org/vuls/id/AAMN-5G62GP>).
These might have allowed a
cracker to cause dataComet-Secure to crash when attempting to open an SSH2 connection (to a host address controlled, or feigned,
by the attacker).
* Added a dialog which allows users to skip connection macro execution for local sessions (whether PTY or SSH->self). This
helps plug a major security hole, since a hostile systems cracker might induce you to download and execute a dataComet Shell
session document containing a noxious shell script embedded in the Connection Macro.
NOTE that Apple's Terminal application will perform similar shell-scripting functions using ".term" and ".command" files, and
this is a serious weakness! (The only way known to me to avoid this vulnerability with Terminal is to disable the Terminal
application by removing the ".app" suffix or deleting it.)
* Avoided NULL pointer dereferences which could cause dataComet to crash under some circumstances when a session document is
opened, or the "Open "Comet Default" automatically on launch" option was enabled (in the "Global" Preferences pane).
* Fixed so "Comet Default" will load previously saved "Comet Default.edit" window text when opened automatically on launch.
* Fixed a crash which occurred under OS X 10.2 when opening a session document saved with an empty "Connect to:" field in the
"Configure Terminal Session" dialog.
* Fixed Telnet and SSH connection handling so that connections are made asynchronously, and the "Reopen session automatically on
failure" option (in the "Session" Preferences panel) works correctly. SSH disconnects due to session failures are now reported
without triggering a dialog box requiring a user response.
* The default connection type is now a local Shell connection.
defined in the "Comet Default" session.

New Shell connections now include any buttons or key macros

* Fixed the "Configure Terminal Session" dialog so that renaming the session to clone a new session will properly copy all the
macros and resources associated with the previously defined session document.
* Emulator handling of very long files (e.g., "cat /usr/share/dict/words") has been fixed so performance no longer bogs down
abysmally when scrollback buffering is enabled.
* Fixed XModem transfers so that they will work!

(A bug in the filename dialog was causing transfer cancellations.)

___________________________________________________
10.0.0 -Secure
1/31/03
___________________________________________________
Bug Fixes:
* The time and packet counter displays have been expanded to display uptimes longer than a month ...

* The File menu New -> Clone menu item has been fixed so selecting the menu item directly works.
* SCP file uploads now update the progress dialog promptly.
___________________________________________________
10.0.0b4 -Secure
10/1/02
___________________________________________________
Features:
* Serial connections are now supported.
* Drag and Drop is now suppported.
Bug Fixes:
* Fixed a 3270 emulator bug in handling the Start Field command which could cause a crash due to dereferencing a NULL pointer.
* Fixed a crash which could occur when a session is opened from a session document (SetPortRGBForeColor() was called with a NULL
colormap pointer).
* Fixed the Control menu "Internet Config" command so it no longer causes crashes under OS X 10.2. (It now attempts to
specifically open the file mapping panel; note that unfortunately user-configurable file mapping is only supported through
Internet Explorer under OS X... but maybe someday this deficiency will be remedied.)
* Pastes into the "Set Registration..." and other dialogs have been fixed so they will use the updated scrap when switching in
from another application.
* Fixed the "Configure Terminal Session" dialog Authenticate "(Alt. ID)" field so that it will correctly send the string as an
alternate user login name when making a Kerberos connection.
* The "Save Configuration..." dialog has been fixed so sessions now saved to the dataComet "Sessions" Folder by default.
* Window controls are now deactivated when the window (or dialog) is in the background.
* The buttons in the top of the emulator window have been changed from round to bevel buttons to save space and look a little
less distracting.
___________________________________________________
10.0.0b3 -Secure
9/3/02
___________________________________________________
Bug Fixes:
* Fixed a crash which occurred when a "New" session was created with PC-ANSI or SCO-ANSI selected.
* Fixed a crash which could occur in SCP binary file transfers.
* Fixed crashes which occur under 10.2 (Jaguar) due to failure of calls previously included in the OS X System which have been
omitted in 10.2 (specifically the tgetent() terminal capability call and the krb5_free_kdc_rep() Kerberos call). The "Default
Folder X" extension also triggers this crash by forcing the linker to attempt to resolve all call references.
* Anti-aliasing is now disabled.

(Per-session control of antialiasing will be added in a future release.)

* Fixed selection handling overflow problem, so selections in emulator scrollback buffers longer than 32,767 lines will be
displayed and copied properly.
* Registered copies of dataComet now work correctly when accessed by users who have read-only access to the application.
* Documents which are only available to the user with read-only permissions can now be opened using dataComet.
* Copy and Paste functions have been fixed so the same scrap is used by both the emulator windows and edit/dialog windows.
caused failures to update the scrap correctly when copying and pasting between the two.

This

* The "SOCKS proxy" address in the "Configure Terminal Session" dialog is now saved correctly in session documents when the
"Global" option is not selected.
* To avoid printing failures where "nothing happens", bitmapped fonts (such as the Comet-fonts) are now remapped to Courier when
printing.
* The VT220 delete character and insert character functions have been fixed so they handle Background Color Erase mode
correctly.

* The SCP and IND$FILE transfer dialog boxes are now drawn completely when an upload command is selected.
* Fixed a loop which occurred if an arrow key was pressed in an emulator after the "!W>\000" macro had been executed to direct
input from the .edit window into the emulator window.
* Added "!Ex" macro to clear scrap (replacing obsolete "!cC" macro).
* Button control sizing was fixed so that no visual artifacts appear

when they are drawn under 10.2.

* The interpretation of internet addresses and domain names in the "Configure Terminal Session" dialog have been changed so
Brown TN3270 document "hostaddr::socket" notation is supported.
* The cursor position report is now updated when a selection is being
"Preferences/Views/Use mouse position").

made in an emulator window (this option is controlled by

___________________________________________________
10.0.0b2 -Secure
8/13/02
___________________________________________________
Bug Fixes:
* The Enter key on the keypad now sends an IBM 3270 Enter rather than

doing nothing when IBM 3270 emulation is selected.

___________________________________________________
10.0.0b1 -Secure
8/5/02
___________________________________________________
Features:
Version X runs under Mac OS X as a native Mach-O Carbon application. Local Shell Terminal sessions are supported as well as
Telnet/TN3270 and SSH1/SSH2 connections. In general X is similar to previous versions of dataComet-Secure, though some minor
changes have been made in appearance and menu arrangement.
BUG NOTES:
* Note that printing with Comet fonts will probably fail to produce any output, since the system no longer supports printing of
fonts provided as 'NFNT' bitmap font resources. Printing emulator screens containing VT100 graphics or other special graphics
characters may prove problematic. Versions of these fonts will eventually be made available in a format that will be supported
under OS X.
* Support for direct access to Serial ports under OS X is not yet supported.
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___________________________________________________
Known System Problems affecting dataComet
___________________________________________________
* WARNING: Radeon video board display bug (4/18/92): The ATI Radeon video drivers installed by default with Mac OS 9.2.2 may
malfunction with dataComet/dataComet-Secure and NiftyTelnet, resulting in incorrect screen displays. Updated drivers from ATI
apparently fix this problem; they are available from
<http://www.ati.com/support/drivers/mac/macos-march-2002-update.html>
* WARNING: Kerberos 5 (4/18/92): The "OT AutoPush Support 1.0" System Extension, which may be installed with Interarchy,
OTSessionWatcher, and other software, causes non-fatal network errors to occur with MIT Kerberos 4.0; you may be better off
disabling this extension. (See "5.0.6b2 -Secure" note below.)
* WARNING: Mac OS 10.1.2 has a fatal bug which causes a system panic when Internet connections are made to one's own Internet
address by an application running under Classic (this works correctly in earlier releases of Mac OS X, and either works or
produces a non-fatal connnection failure in later releases). dataComet now posts an alert warning of this bug when opening a
connection to one's own address.
* NOTE: When running under System 7.5 and later the Standard Put File dialog used in the "Save As..." commands does not by
default get set to the home folder of a document, but instead is set to the most recently opened folder. If you want to get the
correct folder, you need to open the "General Controls" Control Panel and select "Folder which is set by the application" (under
the heading "Documents: When opening or saving a document, take me to..."); this setting will allow dataComet to set the folder
correctly before displaying the Standard File dialog.
* Cancelling an Open Transport PPP session open dialog which has been launched from the "New..." dialog will result in a crash
due to a bug in PPP's dialog management, which releases dataComet's "New..." modal dialog window rather than the PPP dialog
window. This OT/PPP bug only appears when PPP is opened and then cancelled from the "New..." dialog.
* If Diamondsoft's FontReserve Extension 2.0 or 2.0.1 is installed, it will hang when dataComet attempts to open fonts contained
in the dataComet Fonts folder. NOTE: Diamondsoft fixed this problem in version 2.0.2. You can also avoid this by moving the
Comet-fonts from the dataComet Fonts folder into the System Fonts folder.

___________________________________________________
5.0.7 -Secure
6/4/02
___________________________________________________
Bug Fixes:
* The "SCP configuration..." dialog "File modes" and "Directory modes" options now display and set the applicable modes
correctly.

* Source code was recompiled so all features/bug fixes listed below are properly incorporated... a few which were incorporated
in the OS X development version had been omitted from the 5.0.6 build (including the SCP wildcard expansion fix and "rcp" mode
and NCSA-style session logging).
___________________________________________________
5.0.6 -Secure
5/7/02
___________________________________________________
Features:
* "aixterm" escape sequences for host selection of Intense/Light colors have been added for compatibility with PINE's 16-color
mode. (This works only when dataComet's SCO-ANSI 16-color mode is selected; for PINE use, the "Control Emulator..." dialog
option "Wrap text when line overflows" should also be disabled.)
* The "Expire Kerberos tickets on Quit" option now disposes of the user's credentials if and only if they were first acquired
through a dataComet-Secure session.
Bug Fixes:
* The Kerberos connection status notes in the "button bar" are now cleared correctly after connecting in cases where the host
sends display data before the Kerberos negotiations are complete.
* Using Control-key option to get help for items in the "Help" menu no longer causes dataComet to crash.
___________________________________________________
5.0.6b2 -Secure
3/26/02
___________________________________________________
Features:
* Added "Expire Kerberos tickets on Quit" to the "Control Global..." dialog; this option is on by default. Leaving this option
on helps avoid a Kerberos-related bug, which may cause failures when forwarding tickets to the host (which is enabled when "Fwd
Creds" is selected for a Kerberos Telnet session). This bug is apparently caused by interactions with the "OT AutoPush Support
1.0" System Extension.
___________________________________________________
5.0.6b1 -Secure
3/9/02
___________________________________________________
Modifications:
* The Kerberos 5 code was modified to improve memory management.
* The "Comet-APL" font was updated so that it contains 'NFNT' resources rather than 'FONT' resources.
___________________________________________________
5.0.5 -Secure
2/1/02
___________________________________________________
Features:
* An option to use the "rcp" command rather than "scp" was added to the SCP configuration panel so the rcp/scp file transfer
method can be used when the SSH server package does not include support for SCP (e.g., SSH.com's SSH server). Note that using
"rcp" rather than "scp" has no security impact in this case, since the data is being transmitted over the secure terminal
connection.
* Added support for session logging as it is implemented in NCSA Telnet, with the data recorded as it is received, rather than
when it scrolls off the top or is cleared from the screen. The Shift-Option-"Open log..." and Shift-Option-"Log session in"
options to the "Open log" command are used to select this logging mode. This approach to logging helps preserve the host linefeed structure (long lines which wrap down automaticaly at the end of a row on the emulator screen will not have additional
Carriage Returns added).
Bug Fixes:
* Fixed problem with the correct scrap failing to appear in the "Set dataComet-Secure Registration" dialog.
side effect of the OS X paste bug fix in version 5.0.4/4.6.4)

(This bug was a

* ZModem file transfers over serial connections have been fixed so the receive buffer size is correctly initialized in all
cases. (Transfers would fail with an "Out of memory" message unless a Telnet session had been previously opened.)

* SCP file transfer support has been fixed so that wildcard expansion and automatic transfer type selection (Binary vs. ASCII)
works correctly when uploading.
___________________________________________________
4.6.6
2/4/02
___________________________________________________
Bug Fixes:
* Fixed bug in handling old registration code format, which was used in registrations prior to 1998.
___________________________________________________
4.6.5
2/1/02
___________________________________________________
Bug Fixes:
* Incorporates into dataComet bug fixes from dataComet-Secure releases up to 5.0.5.
___________________________________________________
5.0.4 -Secure
1/7/02
___________________________________________________
Features:
* A new feature simplifies opening a Terminal-style local SSH session when using MacOS X: Your own address will be used if no
address is entered in the "New"/"Reconfigure Session..." dialog's "Connect to:" field when the session is configured to connect
using Telnet or SSH. A session document named "Shell" is now included in the "File" menu "Sessions" submenu as an easy-to-use
example.
* A dialog now warns that under 10.1.2 connections to one's own machine (such as the "Shell" document makes) may lead to a
system panic. This is due to a bug in the operating system; under previous releases this works fine.
* Added two "Control Emulator..." options for ASCII emulators:
- "Display full Apple character set", so the characters 0x80 - 0x9F are treated as display rather than control characters. This
option allows you to view all the available characters when connecting to a MacOS X machine (note that some applications under OS
X, e.g. "vi", may still not display characters >= 128 directly).
- "Do CR-LF when CR received" (CR from host -> CR/LF).
Bug Fixes:
* Pasting text under Mac OS X now works consistently so you get the most recently cut or copied text from OS X applications
rather than an out-of-date local scrap. (OS X is not prepared to deliver the correct scrap when it delivers "Resume" event to a
Classic application, so dataComet had to delay its request for the current scrap to get the correct text.)
* Pasting text into dataComet's modal text dialogs now works again.
* An empty Terminal Type "Alt. ID" field in the "New..."/"Reconfigure Session..." dialog is now saved correctly in the session
configuration (this problem occurred only if an alternate string had already been saved).
* Using the mouse to select the "Download" menu item in the "File" menu "Transfer" submenu now brings up a Download dialog
(rather than the Upload dialog).
* A bug which could cause a crash if a PF key greater than 72 (for which no macro had been defined) was triggered by a ShiftOption-"Mouse button" combination has been fixed.
* A bug which could cause the wrong labels to appear in the buttons at the top of the emulator window has been fixed.
* Fixed IBM 3279 display bugs introduced by underline fix in 5.0.2.
* Fixed the 3270 emulator so that DDM file transfer support is included in the Query Structured Field Summary response.
* Fixed the format for the "Host key fingerprint" in the SSH1 login trace so garbage characters will not appear at the beginning
of the fingerprint string.
___________________________________________________
4.6.4

1/7/02

___________________________________________________
Bug Fixes:
* Incorporates into dataComet bug fixes from dataComet-Secure releases up to 5.0.4.
* The Kerberos plugin interface is no longer supported by dataComet.
Secure, which incorporates support for Kerberos 5.

For Kerberized Telnet sessions you should use dataComet-

___________________________________________________
5.0.3
9/2/01
___________________________________________________
Bug Fixes:
* If you have configured a session to do session logging, when the document is opened you can now use the "Cancel" button in the
"Save File" dialog to cancel logging (this formerly required an "OK" response: pressing "Cancel" did not turn off the logging
option, so the "Save File" dialog would reappear as soon as new data was received!).
___________________________________________________
5.0.2
7/30/01
___________________________________________________
Bug Fixes:
* The message "Server initiated key re-exchange" no longer appears in SSH2 sessions.
* A bug was fixed; it affected IBM 3270 emulation, and resulted in underlined blank characters appearing without underlines when
using fonts other than the Comet-Fonts.
___________________________________________________
5.0.1
7/23/01
___________________________________________________
Bug Fixes:
* Telnet sessions now default to sending only a Carriage Return character when the Return key is pressed, rather than Carriage
Return + Line Feed. If a host requires the additional Line Feed character, you will need to set the "LF" option in the "Control
Emulator..." dialog.
* A bug which could cause passwords to appear in cleartext when entered into the SSH dialog password field has been fixed.
* Several bugs which occurred on machines running MacOS 7.5 variants have been fixed. Dialog text and "OK" button rectangles
have been rearranged for better appearance; two bugs which could cause crashes on 68K machines when using the SSH configuration
dialogs have been fixed.
___________________________________________________
5.0
6/15/01
___________________________________________________
Features:
* Telnet DES3-CFB encryption is now supported. Note that some host telnet server implementations declare support for this
encryption type in Telnet negotiations but fail to handle it correctly.
* A "Telnet Configuration" dialog has been added to allow you to select Telnet options such as Authentication (currently only
Kerberos 5 is supported) and Encryption (DES or 3DES).
___________________________________________________
5.0b2
6/4/01
___________________________________________________
Features:
* Telnet connections authenticated using Kerberos 5 are now supported (on PowerPC machines only). Encryption using DES-CFB can
also be negotiated to further enhance session security. (NB: dataComet no longer supports the use of Telnet Plugins to provide
an interface to Kerberos. This enhances dataComet's compliance with the U.S. Federal Export controls on encryption products.)
___________________________________________________

5.0b1
5/10/01
___________________________________________________
Features:
* SSH and Telnet sessions can now use SCP (Secure Copy) to transfer files and folders to a host which has the "scp" application
installed (note that this is secure ONLY with SSH sessions). dataComet's SCP implementation brings up a dialog which issues SCP
commands from the terminal command line, so you can perform file transfers interactively rather than starting a separate session
for each SCP transfer (which in most implementations also requires that you enter a complicated command string containing the
file modes and file names). All of dataComet's standard file transfer features are available when using SCP (Autolaunch,
Autowrap, Command-U automatic edit window uploads, etc.). See the document "6. File Transfers" for more information.
* User names and passwords can be saved in session documents. Passwords are saved in encrypted form; the user enters a Master
Passphrase as an encryption key, so by entering the Master Passphrase once the user can enable automatic password entry for a
number of sessions. The Master Passphrase is never stored; passwords and SSH RSA session keys are both encrypted using DES-3
156-bit strong encryption. A "Change Passphrase" command in the "Control Global..." dialog allows the user to enter a new
passphrase, and automatically update all passwords in session documents contained in the dataComet "Sessions" folder so they will
be decrypted properly when the new Passphrase is entered.
* A "Lock" command allows the user to lock the entry of menu commands and keystrokes until the correct Master Passphrase is
entered. This helps provide improved security; you should be especially careful to Lock your sessions when using the automatic
password entry feature with SSH or when using a "Type password" macro (see "4. Macros").
* A new keypad mode for VT100 was added so a calculator keypad can be used with cursor application mode, which some applications
expect.
Bug fixes:
* SSH zlib compression now works reliably.
crashes.

The implementation in 5.0a5 contained an error which could sometimes cause hangs or

___________________________________________________
5.0a5
3/15/01
___________________________________________________
Features:
* This Alpha Test version of dataComet-Secure adds support for the SSH1 and SSH2 Secure Shell protocols. All features of
dataComet, including ZModem file transfers, work with SSH connections. SSH features supported include automatic SSH protocol
selection, client authentication using user passwords (and under SSH1, using RSA public keys), encryption using Triple-DES or
Blowfish, and compression using zlib. Host public keys are maintained in files using the known_hosts format (e.g., the
"NiftyTelnet SSH Known Hosts" document can be copied directly to dataComet's "Security" folder and used as-is).
Features NOT supported in this release: SSH1 RSA client public key generation; SSH2 public key client authentication; XWindows
or TCP port tunnelling; and SCP or SFTP file transfer protocols. NOTE that this release will not run on 68000 machines such as
the Mac+: it requires a 68020 or higher processor.
NOTE that enabling zlib compression seems to lead to occasional dropped connnections.

This bug is under investigation.

* The registration dialog is now a modeless dialog to make it easier to set your registration: you can now open the dialog, go
to other windows to copy a registration code, and then paste it into the registration text field.
* You can now select a vertical cursor in emulator windows using the "Prefer vertical cursor" option in the "Control Session..."
dialog. You can also opt to have the emulator cursor off when the window is in the background by using "Hide cursor in
background windows" in the "Control Global..." dialog.
Bug fixes:
* Switching windows to a new window while the "Define macros..." dialog is up no longer results in a loop where a dialog
repeatedly prompts you to save the "new document" until you save the document, rather than allowing you to cancel.
* Window selection macro commands have been fixed to work more smoothly, so that if you include a window select command (e.g.,
"!WShostwindow\000") in a macro, all the succeeding macro commands will be copied over to that window's macro queue and executed
in its context. This makes it much easier to execute a macro which copies data fields from an emulator window and pastes them
into an edit window.
* A session document's emulator color maps are now copied when the document is duplicated by changing the document name in the
"New..." (or "Reconfigure Session") dialog.
___________________________________________________
4.6.4b2

12/12/00

___________________________________________________
Features:
* dataComet now supports IND$FILE transfers for IBM 3279 sessions, including features supported in dataComet's ZModem
implementation such as AutoLaunch, text wrapping and unwrapping, and MacBinary and BinHex encoding and decoding:
- The "Upload" and "Download" commands in the "File -> Transfer" submenu bring up a dialog which helps you build and execute an
IND$FILE host command.
- A dialog has been added to configure options available under IND$FILE, and a "DeTab" option has been added to the "Control
File Transfer" dialog for expanding tabs when uploading. (For more information, see the document "6. File Transfer".)
- Macros have been added to set the Macintosh file name and IND$FILE options so IND$FILE transfers can be executed automatically
using macro commands.
Bug fixes:
* The "!WA" macro, which allows you to open items in the Apple Menu from a macro, has been fixed so it works reliably.
___________________________________________________
4.6.4b1
11/1/00
___________________________________________________
Features:
* Improved support for SCO-ANSI emulation, adding SCO and XENIX-specific color selection escape sequences, including background
color selection and reverse color mapping. A new terminal type option has been adding in the "File New..."/"Reconfigure
Session..." dialog to allow explicit selection of the SCO-ANSI terminal type and keyboard mapping.
* For Serial connections you can now enter a telephone number in the "File New..."/"Reconfigure Session..." dialog to which to
connect, making it easier to configure dataComet sessions for dialup connections. This uses a global modem dialup macro which
can be modified using the "Set dialup macro..." command in the Macro menu (the dialup macro is set by default to send "++
+ATH<Return>ATDT" before the number is transmitted to the modem). The "Host Name/Address:" field is now labelled "Connect to:"
in the "New..." dialog.
* An option to "Notify when new data arrives in background" has been added to the "Control Session..." dialog; this sets the
task menu to flash when dataComet is in the background and new data arrives for the session. A "!CN" macro command has been
added to perform this function also.
* A "Next" command has been added to the Window menu to select the next window. You can press "Option-Tab" to select the next
window from the keyboard, and "Shift-Option-Tab" to select the previous window. To accomodate this new keymapping, the IBM 3270
"Select Cursor" command is now executed using "Control-Tab".
Bug fixes:
* SCO-ANSI keymapping now sends a DEL character when Shift-DelRight is pressed (the lower right key in the six-key function
group).
* Macintosh international characters are now automatically remapped to 7-bit National characters when a National Character Set
is selected in VT100/ANSI emulators.
* Text pasted into the "New..."/"Reconfigure Session..." dialog now triggers item updates correctly (this was occurring only
when characters were directly entered into the fields).
* The "ALA" session document has been updated to connect to SUNY Binghamton's library card catalog.
* The Comet fonts have been modified so that ATM Deluxe no longer complains that two of them are "damaged".
there were in fact no problems with the fonts which could cause malfunctions.)

(Please note that

___________________________________________________
4.6.3
5/22/00
___________________________________________________
Bug Fixes:
* The VT320 soft reset command was fixed so it correctly resets character sets and attributes.
* The Enter key function, used in an edit window to send text to a host session, has been fixed so that a Carriage Return will
be added if the last line of text is being sent and it has no Carriage Return at its end.
* ZModem file transfers have been fixed so that control-character escapes are added correctly.

Note that support for 7-bit data

paths (added in ZMODEM-90) has not yet been added, so dataComet's ZModem implementation will fail when using with a 7-bit
connection.
___________________________________________________
4.6.3b1
4/11/00
___________________________________________________
Bug Fixes:
* Printing has been fixed so that crashes will no longer occur when the LaserWriter 8.3.4 driver is used.
* Printing screen selections now works correctly when a single line is selected (previously this printed nothing).
* The font submenus are now fully compatible with Suitcase so the "Font" and "Control Font" submenus now use Suitcase's special
font display capabilities. In addition, this change fixes a Telnet connection problem caused by Suitcase's routines, where
Suitcase's system trap patching caused failures when first attempting to open TCP Telnet sessions (error code -23).
A number of bugs and deficiencies in advanced VT100/VT320 functionality were fixed:
- The display of underscores can now be turned off using the "Do underscore" option in the "Control Emulator" dialog.
- Support for the VT320 soft reset command was added.
- Support has been added for non-standard command sequences using to select the foreground and background colors ("<ESC><nm" for
foreground and "<ESC>=nm" for background; see "1.1. VT100 Command Set").
- The VT320 GR character set shift support has been fixed so VT100 graphics characters are displayed properly when mapped into
GR.
- The SUB (Control-Z) character now causes the display of a '¿' (reverse question mark) in addition to cancelling an escape
sequence.
- Blink attributes now continue to blink when the cursor is hidden.
- The VT100 "Show Cursor" DEC private command no longer causes cursor glitches to be left onscreen when called repeatedly.
* The test used by the ASCII emulators for triggering automatic ZModem downloads has been modified to try to handle all cases
correctly.
___________________________________________________
4.6.2
2/7/00
___________________________________________________
Features:
* dataComet now offers a keypad panel with buttons linked to keyboard function keys (and corresponding macros, if any); the
keypad panel can be opened using the "F" control at the bottom left of the emulator window.
* New default keymapping for "UNIX tn3270" has been added to the "Host menus and function keys" popup menu to make it easier to
use UNIX tn3270 sessions to connect indirectly to IBM mainframes. A new "!K\nnn" macro has been added so the standard keymap
options can be selected in macros.
* A "!CU" macro has been added to allow opening URLs in macros.
* VT100 User Defined Keys now allow the host application to open URLs and execute dataComet macros directly (see "1.1. VT100
Command Set" for details).
* The "Control Printing..." dialog now includes "Eject page when host turns off stream printing" to allow disabling automatic
page feeds when the "end host printing" ESC[4i command sequence is received. This resolves problems caused by applications which
repeatedly embed print stream open/close commands on the same page.
Bug Fixes:
* MacOS X Server host sessions are now negotiated so they work cleanly without changing the default CR-LF settings.
addition, control characters such as ^C now work properly.

In

* The launch macro resource ('CONN' ID=2) resource can now be imbedded in the dataComet application to facilitate distributing
copies of dataComet with restricted feature sets. Launch macros no longer crash or hang dataComet if they are executed without a
window open.
* 14- and 16-point fonts in emulator windows now appear closer to the left margin when fast drawing is not enabled to improve
the appearance of the screen.

* VT100 stream printing now yields to other applications after each page is imaged to help guarantee that print drivers will
process print jobs correctly.
* A bug which could lead to hanging when PowerPCs perform X/Y/Z-Modem transfers using Serial connections has been fixed.
* ZModem downloads now accept Start AutoReceive commands (ZRQINIT) from hosts which contain imbedded commands to avoid
AutoReceive failures (the imbedded commands are ignored, since they are presumably not relevant in the Mac environment).
* BinHex decoding of downloaded files now works correctly when the first line contains the "(This file..." encoding message.
___________________________________________________
4.6.1
10/29/99
___________________________________________________
Bug Fixes:
* The Kerberos data encryption negotiation sequence was fixed so data encryption works reliably rather than presenting garbled
data. (Encryption of sent data was working properly; reception of inbound data started one byte early in many cases.)
___________________________________________________
4.6.1b4
10/1/99
___________________________________________________
Bug Fixes:
* The code handling MacTCP Domain Name Resolution has been updated to be compatible with MacOS 9.
* The 3270 emulator has been fixed so that Structured Field write commands are handled correctly if a length field is split
between two TCP packets.
___________________________________________________
4.6.1b3
9/23/99
___________________________________________________
Bug Fixes:
* Changed the 3270 Query Reply Color Background response in another effort to improve compatibility.
___________________________________________________
4.6.1b2
9/14/99
___________________________________________________
Bug Fixes:
* The 3270 Query Reply Color Background response has been fixed to use $F0 (Neutral-Black) as the default background response.
If the "Control Color..." dialog item "...except Background" is enabled, the 3270 emulator now generates a Query Reply Color
response which omits the Background Color capability.
* VT100 stream printing has been fixed so that pages after the first page are always printed; in some cases following pages were
omitted. In addition, print streams have been fixed to work correctly when the Print Dialog has been turned off (using the
"Control Printing..." dialog item "Show "Print..." Dialog when printing host print streams").
* The XON/XOFF/KILL character fields in the "Control Emulator" dialog have been fixed so that you can use the "delete" key to
turn off special handling of these characters easily. In addition, non-numeric characters entered into dialog fields is now
screened out when it is not appropriate, and pastes have been fixed so that the dialog paste uses the text from the latest copy
command.
___________________________________________________
4.6.1b1
9/3/99
___________________________________________________
Bug Fixes:
* dataComet now handles the Applescript "quit" command in a way that will return a value to the calling script before quitting,
so scripts using the quit command will continue correctly.
* The Query macro command (!QS) has been fixed to prevent the appearance of junk characters in the user input area; !QQ has been
fixed so it now terminates the prompt string correctly.

* The macro dialog now displays the timeout number for the match case macro command (!z) correctly.
* 3270 Extended attribute reporting in responses to Read commands has been fixed so that attributes are only returned when
requested by the application and default attributes are not reported. User selection of extended attributes (reverse,
underscore, and blink) for characters has been fixed so that only one attribute can be applied to a character at once, as
required by the 3270 specifications.
* The 3270 Query Reply Color Background response has been fixed to include the length byte so host programs will interpret it
correctly.
_____________________________________________________________________________
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___________________________________________________
4.6 Final Release
5/20/99
___________________________________________________
Features:
* Wyse-60 function key mapping has been added to the "Host menus and function keys" popup menu.
Bug Fixes:
* Modified the printing routines for better compatibility with the LaserWriter 8.6 driver (in accordance with Apple Technote
#1161, 4/19/99), so that the driver is notified that dataComet correctly handles variant Print Record sizes. This may fix
occasional crashes which have been observed when using LaserWriter 8.6. In addition, the printing routines now guarantee that
the page number is placed within the visible print page (a problem which could result in printing extra pages with some versions
of the Epson print drivers).
* Fixed 3270 Pen Detection to handle Space and Null field responses correctly, so that an 0x7E AID is transmitted with SBAs for
modified fields and no data.
* Fixed the TFTP server so that it works on PowerPC machines, and added receive file processing so received files can have their
file type set from Internet Config and can be launched automatically, and MacBinary and BinHex files can be decoded
automatically.
* Added support for the "<ESC>[Png" escape sequence to the ANSI emulator, which is used by some PC-ANSI host applications to
display a character from the alternate graphics font. (Note that this usage conflicts directly with the ANSI specification,
which reserves this escape sequence for the Tab Clear command: only when Pn > 5 will characters be displayed, otherwise the
sequence is assumed to be a valid Tab Clear command.)
___________________________________________________
4.6fc2
4/26/99
___________________________________________________
Bug Fixes:
* Fixed a crash on 68K machines caused by an uninitialized variable being referenced when no session had been opened and an
alternate terminal type was selected in the "New..." dialog and the dialog subsequently OK'ed.
* The VT100 graphics characters now appear correctly when the Comet PC-ANSI font is selected even when the PC-ANSI terminal type
has not been selected.
* The ANSI/VT100 emulator now handles SCO-ANSI color selection escape sequences correctly, and ignores other commands which use
"<ESC>[=" as an introducer so they will not leave garbage from incomplete commands on the display screen. See "1.1. VT100
Command Set" for details.
* Added a "Background Color Erase" option in the "Color..." dialog so that background color erase can be disabled.
* The selection is now reset after a Control-Click invokes the Contextual Menu Manager and a selection has been made.

* The Paste command now automatically applies text translation from the Macintosh character set to the host character set when
host output translation is selected, so that Copy and Paste using Comet Mona and other Macintosh fonts works seamlessly; formerly
you needed to hold down the Shift key to select translation when pasting. Shift-Paste now forces translation (which does not
occur when output translation is turned off, e.g., when Comet ISO-Latin-1 is selected), and Option-Paste now suppresses
translation.
3279 bug fixes
- Fixed handling of extended stream Write Structured Field packets with "zero" length so that the actual packet length is always
used and set properly.
- Fixed a bug which in certain unusual circumstances triggered the FT3270 file transfer routines, causing valid PF key commands
to be ignored.
- Fixed a bug which sometimes caused 3279 attribute bytes to appear with an extended attribute (such as underline) set.
- Fixed a bug which caused intermittent reporting of normal characters as APL characters; this occurred in the 3279 emulator
when extended reply mode was not selected and a Read Buffer All command was received.
- Fixed a crash which occurred when a 3270 session was closed, was also paged backwards in the scrollback buffer, and dataComet
was Quit. The crash was caused by referencing 3270 memory resources which had already been released.
___________________________________________________
4.6fc1
4/13/99
___________________________________________________
Features:
* dataComet now supports dialup and other serial connections using Modem and Serial ports added with PowerBook, NuBus, and PCI
cards or internal Macintosh modem hardware (as with the iMac). These can be selected from the Serial port list in the "New..."
dialog.
Bug Fixes:
* Macro bug fixes and enhancements:
- Global macros are now processed when no windows are open.
- The "dataComet Launch macro" can now be used to execute any macro commands, rather than being limited to executing security
configuration commands for Public Kiosk configurations.
- Window changes now cause macro commands to be moved to new context, so that recorded macros work in a natural way. Note that
if you are currently using macros to open new sessions, you may need to add "!W}" to the macros after the open if the macros
include subsequent commands (which were executed in the current window context, and would now execute in the new window's
context).
- Edit window keystrokes are now recorded when "Record actions for macro" is on.
- The state of the menu macro Shift and Option keys are now reset correctly when interpreting macros. Menu items with ShiftOption variants can now be recorded and executed in macros ("CapsLock-Shift-Option" is now required to generate a disable-item
macro command when recording).
- Fixed a bug which caused a crash when a global macro was deleted and the frontmost window had no macros defined.
* FT3270 IBM mainframe file transfer bug fixes and enhancements:
- FT3270 downloads now work correctly in the PowerPC version; there was an error in checksum calculations in the C code used
with the PowerPC.
- FT3270 now supports automatic download BinHex/MacBinary translation and launching of downloaded documents.
- FT3270 uploads no longer fail when an 0xFF character is contained in the data.
* The "Control Keypad" dialog item "VT220 named FKeys sent without Shift key down" is now set properly (this bug was introduced
in 4.6b7).
* The standard VT220 function key definitions used when the "Automatic" Host Menus and Function Keys option is selected now send
"<ESC>OT" when F5 is pressed rather than "<ESC>[15~" so the host Print function works correctly with the default definition.
* Font scaling is only enabled when printing to help avoid ugly font scaling in emulator display screens (this problem was
introduced by printing fix included in 4.6b7).
___________________________________________________

4.6b7
3/22/99
___________________________________________________
Features:
* A number of new Mac <-> 3270 Translation tables have been added to support international applications.
* The "Comet Default" preferences document is now located in the "dataComet Preferences" Folder in the System "Preferences"
Folder. User "Documents" and "Sessions" folders are also now located in the "dataComet Preferences" folder, to make upgrading
dataComet versions easier and provide compatibility with MacOS X Server's NetBoot capabilities.
* Option-"Open Log..." now selects a file to log all session data transmissions for debugging purposes; this option will provide
reliable logs even in cases where crashes occur!
* The VT100/ANSI emulation has a number of improvements and bug fixes:
- Background Color Erase is now supported, so that erased areas are set to the current background color.
- A number of new VT320/ISO-6429/ECMA-48 command sequences are now supported by the emulator: 8-bit control transmission
(S7C1T/S8C1T), Erase Char (ECH), Protected-Areas (SPA), DEC Protected-Areas (DECSCA), Send/Receive mode (SRM), Visible/Invisible
Cursor (DECTCEM), Character-Position-Absolute (HPA), Cursor-Back-Tab (CBT), Cursor-Character-Absolute (CHA), Cursor-HorizontalIndex (CHT), Line-Position-Absolute (VPA), Next-Line (CNL), Previous-Line (CPL), Repeat (REP), Pan/Scroll-Down (SD), Pan/ScrollLeft (SL), Pan/Scroll-Right (SR), and Pan/Scroll-Up (SU). See "1.1. VT100 Command Set" for the sequences used to invoke these
commands.
- New function key mapping options have been added for ANSI emulators in the "Host menus and function keys" popup menu, which
now appears in the "Control ASCII Emulator..." dialog as well as the "New..." dialog. (This makes it easier to select function
key mappings appropriate for connections to hosts using linux, scoansi, xterm, and at386 terminal types. This option replaces
the "Select IBM menus and keymapping" option in the "Control Emulator..." dialog and the "NCSA FKey mapping" option in the
"Control Keypad..." dialog.)
Function key options have also been expanded so that 72 function keys can be easily selected: When you press a key or
function key button, pressing Shift shifts up 12, pressing Control shifts up 24, and pressing Option sends functions associated
with the "Home" and other middle-pad function keys. The shifted state is now promptly reflected by the labels on the function
button names on the left hand side of the emulator screen which are displayed when you press the '?'/'M' button.
NOTE that "Command-button" is now used to set button macros rather than "Option-button", and "Command-macro menu" sets menu
macros rather than "Option-menu". Also, the "Home" and other middle-pad keys are now mapped in a more "natural" fashion: See
"0.1. Shortcuts", which has been updated to reflect these changes in function key mapping.
- The VT100/ANSI emulator now supports Set Graphics Rendition (SGR) commands to set the default foreground (black, "<ESC>[39m")
and background (white, "<ESC>[49m") colors.
- ESC and SGR commands which are used to select the PC-ANSI alternate characters were also added. "<ESC><char>" remaps the next
character for display when it is greater than 159, where 160 -> 127, 161-191 -> 1-31, and 192-223 -> 128-159. "<ESC>[10m"
selects the default font, "<ESC>[11m" allows display of the alternate font characters in positions 0-31, and "<ESC>[12m" selects
the alternate font and displays shifts the character into the high range (128-255).
Bug fixes:
* Setting the terminal type when first creating a "New..." session no longer results in a crash (this bug was introduced with
the improved color maps support added in 4.6b6, and was caused by a premature attempt to select the window's screen graphics
device when it had not yet been identified).
* PC-ANSI graphics characters less than 32 now display properly (this bug was introduced with support for the 3270 extended
attributes).
* 3279 emulation bug fixes:
- The 3270 now sends only Start Field orders (rather than Start Field Extended) when extended reply mode has not selected by the
host. This caused problems with the RDRLIST command failing to execute keyed commands.
- The 3270 Repeat to Address order now uses the APL translate table to translate characters when the alternate APL character set
has been selected using a Set Attribute order; failure to do so was causing some characters to appear incorrectly.
- 3270 fields with extended attributes selected are now drawn correctly when they appear at the end of a line immediately after
a field which also had extended attributes (rather than using the attributes associated with the previous field).
* Printing fixes:
- Printing a selection in emulator windows sometimes resulted in a crash during recalculation of the character width table...
this is now done after the Print Driver is closed to avoid this problem.

- Printing text windows using monospaced fonts now places words so that they always have a space after the previous word.
- The Comet fonts are now scaled so that when they are printed they are larger and more legible.
- Page range selections made in the "Print..." dialog now work correctly.
- Fonts have been uniformly updated to use a slashed zero (0) rather than a dotted zero, since the dotted zero could be confused
with an eight. The new slashed zero is slashed at the bottom to avoid confusion with the slash-oh character (¯), which is
slashed in the middle.
___________________________________________________
4.6b6
2/3/99
___________________________________________________
Features:
* The IBM 3279 now supports background colors, the Graphics Escape command, and the APL character set. NOTE that you may need
to update the color mapping in the "Color..." dialog using the "Default Colors" button to get correct background colors for color
3279 sessions created using earlier versions of dataComet 4.6!
* Session Keepalive and "Reopen session automatically on failure" options have been added to the "Control Session" dialog.
* File Transfer: An "AutoDecode" option has been added to control BinHex and MacBinary decoding of downloaded files.
containing multiple binhexes (e.g., mailboxes) now download OK, and all binhexes unpack correctly.

Files

* When using VT100/VT220/PC-ANSI emulation the buttons on the left side of the screen now send VT220 Function keys by default
rather than VT100 application keypad commands; you can send the VT220 "Find" and other special keys using F1 through F4 and F23
and F24 (see "0.1. Shortcuts"). This makes it easier to use dataComet with the new standard Macintosh keyboards, which lack
these keys. In VT100 -> IBM key mode the buttons will send the default IBM PF key sequences.
Bug fixes:
* The IBM 3279 now handles 2-byte long extended stream packets which claim to be of "zero" length correctly rather than
crashing.
* In some circumstances the first 3279 screen would be filled with junk characters due to failure to set the NULL character
variable before screen initialization occurred. This problem has been fixed.
* IBM 3270 invisible fields now remain hidden on printed output.
* The IBM 3270 PF1 and PF3 key combinations (Control-7 and Control-9) have been fixed; these were broken when Control-attribute
options were added in 4.6b1.
* The IBM 3279 now sends the NULL query reply correctly.
* Long session names are now truncated uniformly; variation between the document name and the name in the menu was causing .edit
save failures when names were longer than 25 characters.
* The "lines in scrollback buffer" in the "Control Session" dialog has been fixed so that it works correctly.
* The correct alert text is now presented when you launch dataComet, option-key remapping is selected, and the "dataComet
Keyboard" was not installed; the text said "Receive" rather giving the instructions for installing the resource.
* Improper placement of the emulator window when the window was placed close to the top of the screen on an alternate monitor
and the status bar was not displayed has been fixed; the text window now zooms correctly when located on an alternate monitor.
* Text windows are now positioned below the emulator window by default when the screen is large enough to allow this placement.
* The default print font size is now 10, and the default QuickDraw left margin is now 72 pixels (1 inch) to give best results
printing with Courier; the font size menu now includes all font sizes to make it easier to select alternate print font sizes when
the current display font does not offer all font sizes. The default text window zoom size is now 512 pixels so the text has an
optimal width when printing with the default settings.
* Several minor problems with color map settings have been fixed; the color map is now always set correctly on session open
without an additional screen update event (e.g., a window selection), the background screen color is always set correctly without
an update, and the VT100 always inherits a VT100 color map (rather than a PC-ANSI color map)
* Fixed the Apple Menu so a disabled line is added between the dataComet items and other Apple Menu items when the Appearance
Manager is not present.
___________________________________________________
4.6b5

12/22/98

___________________________________________________
Bug fixes:
* The IBM 3279 Character Set response to a Read Partition-Query command has been fixed so that TSO & ISPF will no longer crash
with a divide by zero error (TSO was dividing by the "character set descriptor length" parameter, which as reported by dataComet
contained an invalid value of zero).
* 3279 underscore and reverse extended attributes are no longer drawn in field attribute bytes.
* A bug in the 68K implementation of the 3279 which caused bad output to be sent to the host has been fixed.
introduced when 14-bit address support was added in 4.6b3.)

(This was

* VT100 graphics characters now display correctly when Fast Drawing mode is used.
* A rare VT100 drawing glitch was fixed; this bug caused extra spaces to be added after zero-width characters from a
proportional font were drawn.
___________________________________________________
4.6b4
12/17/98
___________________________________________________
Bug fixes:
* The 3270 emulator now includes a Summary reply in its response to a Read Partition-Query command.
in the response was causing problems with some IBM host applications.

The omission of this field

* The VT100 emulator has been fixed so that VT100 graphics characters included in packets with less than 20 characters now
display correctly when a Macintosh font is used (this bug did not appear when using the Comet ISO-Latin-1 or Comet DECMultinational fonts or when the graphics characters were included in larger data packets).
* The 5250 key mode now sends the default keys supported by the AS/400 for VT100 emulation when ANSI/VT emulation is selected.
A bug which caused a dataComet to hang when the IBM Clear key or menu item was selected when using ANSI/VT emulation was also
fixed.
___________________________________________________
4.6b3
12/11/98
___________________________________________________
Features:
* An "Alt. ID" field has been added to the "New..."/"Reconfigure Session..." dialog to allow entry of an alternate Telnet
Terminal Type.
* "Disable fallback to 24 X 80 screen" has been added to the "Control Emulator" dialog for the 3270. This option allows you to
disable host-selected fallback to the 24 X 80 default screen size from larger screen sizes, so the contents of the scrollback
buffer can be preserved in cases where the default screen size is only temporarily reset and not actually used.
* Two icon flags have been added to the horizontal scrollbar indicator area: a lock icon has been added to show when encryption
is on, and a printer icon has been added to show when VT100 passthru printing is on.
Bug fixes:
* 3279/Extended Stream bugs:
* 3270 printing has been fixed to eliminate spurious attributes, which appeared as a result of changes in 4.6b1.
* The Structured Field Erase/Reset command has been fixed.
* The Read Modified All command is now supported.
Clock hang on some systems, requiring a local Reset.

Due to this bug use of the PA1, PA2, and PA3 keys sometimes led to an X-

* 14-bit addresses are now enabled so that custom 3270 sizes > 4096 bytes will work correctly.
* The buffer size is now reported properly in the Query Usable Area response; the 3270 was always reporting it as 1920 bytes,
which caused some host systems to fail to use the full buffer for alternate sizes (even though the row and column sizes were
reported correctly).
* Under certain conditions the 3270 terminal was not automatically resized when it was re-opened after a new terminal size was
selected in the "Control Emulator" dialog. It should now always be resized correctly when it is re-opened. The Row and Column
options in the ANSI/VT100 Control Emulator dialog are now disabled to prevent resizing while the 3270 is active.

* Pointers to the locked default color map resources are now stripped to 24 bits when running on pre-System-7 24-bit color
systems to prevent address errors.
* The "Control Color" dialog now saves old-style color maps if the "Host selects color" option is toggled; if the old map had
not been modified, it was lost during the toggle (unless Command-. or Command-Z was used to Revert the color map to its previous
settings).
* Command-D now dismisses dialogs which have a "Don't Save" button.
___________________________________________________
4.6b2
11/14/98
___________________________________________________
Bug fixes:
* Font settings are now saved when the "Comet Default" document is modified.
* The Appearance Manager and Contextual Menu Manager interfaces are now incorporated into the code so Mac0S 7 launches work
correctly if these extensions have not been installed.
* The "Mac {} IBM_37USA+" character map is now fixed so NULL is mapped correctly to 0x00 (rather than 0x20) when "Send Imbedded
3270 Nulls as Blanks" is off.
* A 3278 display bug introduced in 4.6b1 has been fixed; the bug caused the first field in a screen to sometimes be displayed
with the wrong attribute. This bug did not affect 3279 displays.
* The backspace key now works when an edit window is full.
* Separate Color map resources are now used rather than saving the map in the 'CONF' resource so session colors saved separately
on a per-termtype basis; colors are now updated immediately when they are modified so there is no need to use "Save
Configuration..." to make them permanent.
* The Help document on dialogs has been split into two parts.
___________________________________________________
4.6b1
11/1/98
___________________________________________________
Features:
*** dataComet now includes Kerberos Authentication and Encryption support for all Telnet sessions using Telnet Plugins.
*** dataComet's user interface has been improved: it now uses the Appearance Manager... and...
* The "New..." dialog has been revised to use popup menu items, and includes Authenticate and Encrypt options to support
Kerberos Telnet connections, with a new field which allows you to enter an alternate Kerberos User ID to log on to hosts for
which you have a login name which differs from your Kerberos ID... and...
* The configuration dialogs have been revised to make it easier to find and select configuration options; they now use Geneva 10
font, have a more logical arrangement of items and better wording for the option descriptions, and include a dialog bar which
allows you to jump to the other configuration dialogs... and...
* Contextual Menu support has been added to provide full compatibility with Apple Data Detectors and other Contextual Menu
plugins. The Control-Click "Help" and "Send Selection" features previously implemented in dataComet are now listed in the
Contextual Menu brought up by a Control-Click. Control-Clicking on text in an emulator or edit window now sends the selection if
one has been made, rather than always sending the word which was clicked.
*** dataComet now supports true IBM 3279 color screens and extended attribute processing (underline, reverse, and blink).
"IBM" menu and macros now include items which allow you to set the attribute for typed characters or the selection range.

The

* Escape sequences used by SCO-ANSI emulations have been added to the VT100/VT220 emulator to make it possible to use
dataComet's VT100 emulation with hosts which expect SCO terminals.
*** "Comet Mona" and "Comet Mona Bold", a Comet font family which provides a fixed-width rendition of the standard Macintosh
character set in sizes 8, 9, 12, and 16, are now the default fonts for new sessions; Courier 12 is now the default print font, so
that printing will have the highest quality appearance, and good results can be obtained without installation of the Comet fonts
in the System Fonts folder. The Comet ALA, PC-ANSI, ISO-Latin-1, and DEC-Multinational fonts are still included to make it
possible to get perfect reproduction of host character sets.
* All Comet fonts except "Comet ALA" and "Comet PC-ANSI" now include the "Euro" symbol, replacing the "International currency"
symbol.
* The default 3270 Mac <> IBM character mapping has been changed, and now supports all the characters in the IBM ISO-Latin-1

character set.

Mappings have been added in the "IBM" menu for the "" (DUP), " " (Field Mark), "..." (Record Separator) keys.

* A "Selection Word Count..." dialog has been added to the "Edit -> Selection" menu, which can be opened using a new "#" control
in edit windows.
* "Erase EOF when pasting to clear previous contents" has been added to the 3270 Emulator dialog to improve paste functionality.
This is now the default.
Bug fixes:
* A "Set dataComet Fegistration..." menu item has been added to the Apple menu to make the procedure for registering more
obvious.
* The addition of dynamic macro memory allocation in 4.5.2B made it possible to crash if all windows were closed, the last
session closed had executed macros, and the next session opened executes macros. This bug has been fixed.
* "Menu select" macro commands placed in the middle of a macro now now execute in their current place in the macro stream,
rather than being appended to the end. E.g., inserting a "Return" using the "ASCII" menu now works as expected if it has been
placed in the middle of a macro, rather than sending a Return after the rest of the macro has executed.
* dataComet no longer sends a Telnet "WILL ECHO" response to request to "DO ECHO" from a host, since this confuses some telnet
servers.
* The Bold Font menu has been fixed so the selected bold font item is correctly noted when a new Font has been selected (this
bug was introduced in disables )
* Color selection and inversion is now performed reliably on secondary monitors.
* The VT100 emulator now preserves double width and height attributes when host color mapping is on.
option is now TRUE by default.

The "Use host color"

* The default color mappings for both the VT100 and IBM3270 emulators have been improved so the default colors are nicer.
3270 default attribute colors now match the standard defaults for the 3279 extended base color option.

The

* Blink attributes now blink when viewing the scrollback buffer.
* Toggling "Use Host Color" in the "Color" dialog now updates the background color in the frame surrounding the emulator drawing
area.
* The emulator drawing area clipping region has been changed to eliminate character overhangs which (infrequently) left garbage
from oversize characters appearing on the right edge of the screen.
* Download printing of files has been fixed so that it works correctly with print font selections (4.5.1 introduced a bug which
made this feature work only when "Use Courier font for printing" was selected). Download printing now works with Z-Modem
downloads.
* Serial printing can now be resumed without closing the window after cancelling the serial print.
* The edit window now avoids TextEdit "duplicate cursor" images which appeared when a single character selection (at the
beginning of a line after a Return) was replaced with another character (or cleared).
* Text copied in dataComet now pastes correctly into the Standard File dialog name field.
* YMODEM downloads now work correctly. XMODEM uploads now display the progess indicator correctly. (Note that the download
progress indicator does not show the progress, because XMODEM includes no information on the length of the file being
downloaded).
* Horizontal scrollbars now track correctly in the 68K version when the scrollbar thumb is used.
_____________________________________________________________________________
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___________________________________________________
4.5.3A
8/18/98
___________________________________________________
Features:
* There's now a Registration dialog to make registering more intuitive.
* dataComet documentation is now listed in the Help menu (under System 6, it's listed in a Documents->Help submenu).
Documents and Sessions menus have been moved to the File menu.

The

* "Shift-Open" now displays all files in the Get File Dialog and opens them as text, so dataComet can now be used to edit
documents such as Apple Modem Scripts or NCSA documents (which are indeed text documents, but are set to a different file type).
dataComet no longer adds dataComet window and font size resources to files if they are not dataComet documents (either originally
created as dataComet documents, or saved used Option-Save) so that such documents can be viewed without modifying them. You can
save the window and font size resources in non-dataComet documents using "Shift-Save" (this is not done automatically due to the
low but real risk of Resource ID conflicts).
* Switching windows is now faster; drawing of controls and menus has been optimized.
* The "Find" dialog now has an "Ignore case" option; this is now the default behavior for the "Find" command.
* The "Control Session..." dialog now includes a "Don't Beep" item so you can disable emulator beeps.
* 5250 keys and menus are now available as alternatives to standard 3270 keymapping to make it easier to use the 3270 emulator
to connect to IBM AS/400, System/36, and System/38 hosts. You can enable 5250 key-mapping using the "Use IBM 5250 Keymapping and
Menus" control in the 3270 "Control Emulator..." dialog.
* "Cursor Select" has been added to the IBM menu and associated with the Option-Tab key to provide this function on the
keyboard. Control-Return now performs a Clear to make it easier to execute a Clear on the keyboard.
* A large set of Translation tables have been added to the distribution, including IBM, ISO, and Windows mappings for MacArabic,
MacCE, MacCyrillic, MacGreek, MacHebrew, MacPersian, MacRomanian, MacThai, and MacTurkish.
* New indicators have been added to the left of the horizontal scrollbar in emulator windows; the 3270 busy symbol and VT100
LEDs appear here. In addition you can now display the current emulator cursor row and column coordinates in this area, using
either the host cursor location or the mouse cursor location (you can control the display of the coordinates using the "Show
cursor position" and "Use Mouse position" controls in the "Control Controls..." dialog).
* A macro was added to send the 3270 ATTN key ("!PA").
* The new built-in support for NCSA and Brown document launches from Netscape now also supports Sets, so these documents can be
used to open several documents at once. These documents can be edited using "Shift-Open" or by selecting the document in the
Sessions menu with the Shift key held down (e.g., "Telnet Set Example" in the Sessions menu).
* The 3270 emulator now supports the Structured Field Query Reply, so that session passthroughs to IBM mainframes which failed
when the host (incorrectly) assumed Extended Stream support would be available will now succeed.
* You can now set Leading in edit windows... this feature makes the dataComet on-line documentation much more legible! (The
documentation uses the Monaco font, which really needs the additional leading...) You can also set Print leading independently
of the screen leading.
* The "Define Macro..." dialog now always uses a 9 pt. font when displaying the macro.

* Horizontal scrollbars in both edit and emulator windows now update the contents as you are scrolling.
* The File Transfer submenu now includes several items from the "Control File Transfer..." dialog to make it easier to change
settings on the fly (e.g., "Use BinHex"). These items can be used with edit windows; the settings are applied temporarily to the
target upload session when the File "Upload..." command is used to upload an edit window.
Bug fixes:
* Several dialog items which were truncated when displayed using the Chicago font have been resized so they display correctly.
* Document and session names are now displayed correctly in menus when they contain characters such as "!" (which are
interpreted by the standard AppendMenu() calls as commands to use special formatting for the menu item).
* Pastes into edit windows are now checked to guarantee that adding the text won't exceed the 32K TextEdit limit, and an alert
is presented if this is the case.
* The Translation menu is no longer disabled for edit windows, allowing use of the Option-Translation feature documented in "0.1
Shortcuts".
* When a window is closed and a dialog window becomes the frontmost window, the next frontmost emulator or edit window becomes
the key window for the Find and other dialogs.
* In some situations when an emulator window was opened on a second monitor, it would be resized so it had zero width... this
side effect from adding horizontal scroll bars and window maximum size constraints has been fixed.
* The IBM 3270 cursor is now hidden when drawing occurs.
* The cursor is now updated promptly when a cursor motion key is held down, rather than not being displayed until the key is
released.
* Bugs in the 3270 Alternate screen to Default screen (24 X 80) fallback which cause the screen display to appear incorrectly
have been fixed. Also, pressing the Clear key no longer automatically causes the scrollback buffer to be cleared when using an
Alternate screen size. The buffer is still cleared if the size changes, since the 3270 buffer display routines can only handle
one 3270 screen size.
* Several emulator screen/stream printing bugs have been fixed... Printouts of VT100 scrollback buffers larger than one page may
have had garbage appearing at the end, and the last line on a page is no longer duplicated at the top of the next page. VT100
print streams caused some Print drivers (and network printers) to hang due to failure to call PrClosePage() before calling
PrCloseDoc(). Printing of emulator screens now works on PowerPCs.
* ZModem upload throughput and reliability have been improved. ZModem now avoids prolonged "Sync" states which sometimes
occurred when slightly out-of-date ACK packets from the host were counted as an error and NAK'ed. The default ZModem Upload
Window is now set to 4096 by default to avoid host buffer overflows; you may be able to improve performance by changing this to
0, but be cautious... some hosts (e.g., UNIX hosts with small tty input buffers) may crash due to buffer overflows on Telnet
ZModem transfers! (This generally only occurs during Binary uploads.)
* The PowerPC version is now compiled with the Metrowerks Global Level 1 register optimization off.
cause some odd failures in code generation.

This option was found to

___________________________________________________
4.5.2B
6/16/98
___________________________________________________
Features:
* dataComet is now distributed as a fat binary which offers native PowerPC support in addition to including 68000 code for older
Macs.
* dataComet can now handle Netscape launches directly, so the dataComet-NCSA and dataComet-Brown applications are no longer
included in the distribution. (This means NCSA and Brown users can now try out dataComet without confusion from having the
document icons change to dataComet icons, and existing NCSA and Brown documents will continue to work normally without deleting
the dataComet-NCSA and dataComet-Brown applications.)
* A "Sessions" submenu has been added in Apple menu to provide easy opening of emulator sessions. dataComet now checks the
"Sessions" folder when performing URL or Netscape launches for existing documents with the same name, so session configurations
can be retained between browser launches.
* Horizontal scrollbars have been added to emulator and edit windows. Edit windows feature controls next to the horizontal
scrollbar to allow easy execution of text reformatting commands using the mouse. The "Control Controls..." dialog now includes
"Show horizontal scrollbar at bottom of window" so you can hide the horizontal scrollbar in emulator windows.
* "Option-click sends cursor motion key sequences" has been added to the "Control Global..." dialog; this setting is now on by

default. Formerly cursor-key sequences were sent whenever the mouse was clicked in an emulator window; now you need to hold down
the Option key to send these commands when in ASCII emulator windows. This option allows you to switch this behavior so a simple
click will perform cursor positioning.
* An AppleScript "targetwindow" command has been added. This command selects a target window for dataComet AppleScript
commands, rather than using whatever window is frontmost, so AppleScript commands will be executed in that window context even if
the front window changes.
* An alert was added to remind the user that selecting non-standard font leading and width options in emulator windows slows
down drawing performance.
* An alert was added to note that some menu commands are not executed when a window has been miniaturized (the commands are
ignored in order to help avoid the possibility of mistakes caused by failure to notice that an iconified window is actually
topmost).
Bug fixes:
* The IBM 3270 emulator now handles shifts back to 24X80 mode from larger screen sizes.
when the host application selected the smaller screen size.

This bug resulted in confused displays

* Macro dialog fixes: The "Rename" button is now enabled when no macro exists yet for an emulator button; The "Set" button is
now enabled without changing a macro (making it easier to configure empty key macros); selecting the "Global" check box now
prompts an alert to save changes if a macro has been modified rather than updating a macro automatically. Renaming an emulator
macro button twice no longer causes a crash. Assigning macros to buttons now results in correct display immediately when a
session is configured with "Only one session per document" off (rather than being displayed correctly only after the window is
closed and re-opened).
* Macro handling has been modified so that the queue is resized automatically when macros add commands to execute which exceed
the current queue size. This also saves a lot of memory, since each window saves up to 32K which had been allocated for the
macro queue in previous versions.
* The "Macro" menu is now always rebuilt so it appears after the "Control" menu after adding a menu macro to the Macro menu.
* Pressing "Return" in the "Configure Session" dialog now works as an "OK" rather than being ignored.
* PPP connections are no longer opened automatically as soon as a session document is opened (this occurred even when the
session was set not to connect automatically on open; this premature PPP open resulted from resolving the host name before it was
necessary).
* Using Control-"Menu select" to get help no longer causes a crash under System 6.
* The File menu item "Print now" is now disabled unless applicable (i.e., when VT100 a print stream has accumulated without a
page eject).
* Outdated items for setting MacTCP options used with obsolete versions of MacTCP were removed from the "Control Global..."
dialog.

___________________________________________________
4.5.1
5/4/98
___________________________________________________
Features:
* dataComet 4.5.1 offers a simplified registration procedure. Registered users will now receive via plaintext email a
registration code which sets the registration when it is selected and the menu command Shift-"About dataComet..." is executed.
The previous method of registering using a dataComet document still works; the new method will make it easier for users to
receive registrations when they receive email on a host rather than downloaded to their Macintosh.
* A session timer is now displayed next to the packet counters.
Controls..." dialog.

The display of the timer is controlled in the "Control

* A "National" submenu has been added to the "Control" menu to set National Replacement Character sets (this does not yet apply
to IBM 3270 emulators).
* The "Find..." dialog now reverses the search or replace direction when the shift key is pressed.
* An 8-point font has been added to the "Comet ISO-Latin-1" font family to make it possible to display 132-column screens on
smaller monitors. A native Macintosh version of this font has also been added ("Comet Mona").
Bug fixes:
* The error message "Application predates configuration version" has been removed, since it makes reversion to an earlier

version a hassle.
* Control-Clicking on the menu bar to get help on a menu item no longer brings up "Shortcuts" before user can get to the menu.
(This worked, but the Control key had to be pressed after clicking on the menu bar.)
* Native MacTCP sessions can now be reopened after they have been closed from the host end of the connection (as opposed to a
"Close session" command). (This bug was not present under OT/MacTCP.)
* Macros generated using the Record Macro feature now work correctly when used with an IBM 3270 host.
when 3270 translation tables were added.

This bug was introduced

* The "Control" submenu "Bold Font" option "Use Normal Font" is now saved correctly in the window's font configuration.
* The "Replace All" command in the "Find..." dialog now quits reliably after one time around the text in an edit window.
* Selections in the emulator window which start on the bottom line and include the last character are now inverted properly;
previously the selection was copied properly, but the selection was not displayed if the screen was scrolled so only the first
line appeared. Also, selections made downward from the far right column of a screen row now add a Carriage Return as the first
character when a "Copy" command is executed.
* The emulator cursor is now updated promptly when the emulator screen is not the frontmost screen, so you don't have to bring
the screen up to see the current location of the cursor. The cursor blink is now synchronized with emulator blink field
blinking.
* Closing an unsaved "Untitled" window no longer changes the window position and font/size settings of the "Comet Default"
document, so new windows no longer inherit these changes.

___________________________________________________
4.50
1/29/98
___________________________________________________
Features:
* The "Bold Font" submenu now allows you to select "None" as an option to avoid bolding, which may draw relatively slowly if a
standard Macintosh font is selected.
* The VT100 emulators now map the MacOS 8 "VT100" font graphics character symbols automatically when this font is selected
without using a Comet font.
* A "CharcoalMenus" resource file has been added so that menu items line up properly under MacOS 8.
Bug fixes:
* Prior to opening the Mac standard Select Color dialog the amount of memory available is tested to avoid crashes due to out-ofmemory conditions.
* When using MacTCP new host data was sometimes written to the screen when a window was scrolled. The scroll alert should now
always alert you to scroll to the end of the buffer prior to screen updates, which should only occur after you have scrolled to
the end.
* Page sizes should now be correctly initialized when using VT100 print streams with QuickDraw printing, correcting a bug which
printed pages with only one line of text. In addition, selecting an alternate print font should work correctly under all
circumstances (formerly Courier was being substituted for the selected font in many cases). The serial print Top margin item in
the "Control Printing..." dialog is now updated and saved correctly when it is modified.
* The cursor is now reset to an arrow when it's moved off the left hand side of the emulator screen, correcting a bug in which
it was left as a text selection cursor if "Show cursor-buttons on the left side" was not selected in the "Control Controls..."
dialog.
* A separate font translation configuration setting is now saved so that transitions from TN3270 to VT100 sessions will no
longer produce junk screens caused by inapplicable translation table settings.
* Resources in the "Fonts" folder are now left in the beginning of the resource chain so that international menu and dialog
resources can be dropped in the Fonts folder rather than embedded in the application for maximum flexibility.

___________________________________________________
4.50B1
11/28/97
___________________________________________________
Features:

* X/Y/Z-Modem file transfers are now supported, with BinHex and MacBinary file conversion and automatic launching of downloaded
files using Internet Config File Mappings. Macros have been added to support Z-Modem file transfer: '!fFfoldername' to set the
download folder, and '!fUfilename' to transmit a file.
* Internet Config is supported directly, so that it's no longer necessary to install ICeTEe to resolve URLs in dataComet
windows.
* The Find dialog is now modeless and allows you to enter both the Find and Replace strings. It also includes buttons which
allow you to perform "Replace/Find", "Replace All", and "Undo" operations (Undo does not undo "Replace All" changes).
* The VT100 and PC-ANSI emulators now support VT220 commands which allow the host to set the PFKeys (User Definable Keys, or
UDK). The UDK commands can also be used to independently set the labels and macros associated with the buttons in the button bar
and the left hand side of the screen.
* The VT100 emulator now supports displaying and setting an underline color using the "Extended" color mappings control in the
Color Dialog... NOTE that if an older color VT100 session now displays underlined fields incorrectly (e.g., black on black!),
updating the "Extended" color settings will fix the problem.
* The "Control Print..." dialog now allows you to set top and bottom margins for QuickDraw printing.
field does not clip the drawing; it is used only to center the page number).

(Note: the right margin

Bug fixes:
* dataComet's timers no longer rely on a Macintosh Vertical Blanking Retrace (VBL) routine, since this routine fails to keep
time correctly under OS8 (and must be removed anyway to port dataComet to the PowerPC).
* Using "Control-Menu Select" to get help no longer causes crashes when items in the "Edit Selection" menu are selected (the
memory allocated for the names is now longer to avoid overruns).
* TFTP has been fixed so that turning off the server no longer causes an infinitely repeating error message ("no buffer return")
under OS8.
* The Telnet layer no longer reports errors in Telnet terminal type negotiation (since OCLC negotiations always fail...).
* The File menu "Open..." dialog now shows all documents by rather than only dataComet documents, so it's easier to open text
documents created by other applications.
* The Clipboard is now updated correctly when dialog items are cut or copied.
dialogs.

You can now use Command-A to "Select All" in

* Text wrapping in edit windows using the Edit menu command "Add Returns" has been fixed so it no longer replaces the first
Carriage Return with a Space if the first character is non-blank.
* Cursor motion in edit windows has been fixed so the text cursor moves up and down correctly from the last line when it
contains only a Carriage Return and no text thereafter.
* Edit window printing no longer adds a leading blank line on the first page of printed output.
* "Record macros..." has been fixed so that a rare condition is avoided where the host returned output before the sent data was
recorded for automatic match generation, resulting in the generation of a match-string which fails to work.
* Using Enter to send text from an edit window to an emulator window now sends the selection to the host when Key Macros are
turned off in the emulator window, rather than pasting it at the end of the edit window itself. Enter now sends the whole
paragraph, including preceding lines, rather than just the text on and below the line containing the selection.
* Bold characters are now drawn for Macintosh font families when color is on.
* An error affecting the drawing of screens when scrolling in the scrollback buffer has been fixed, so that incorrect characters
no longer appear on the screen. The problem occurred due to a bad blank count accumulating when fonts needed to be switched from
a type which has to be clipped for drawing (e.g., Monaco Bold) to one which does not (e.g., Monaco), which could result in the
failure to erase or draw a character position at the end of a field.
* Likewise, a problem where garbage is left from previously drawn but not-fully-erased characters on the left hand side of
characters which require clipping has been fixed.
* 3270 session character translation is reset to default ASCII when IBM 3270 -> ASCII linemode fallback occurs so ASCII
characters will display correctly while in linemode.

___________________________________________________
4.43B8
9/15/97
___________________________________________________

Bug fixes:
* A
Type
to a
say,

bug afflicted 4.43B6 which allowed a junk "global key macro" to be "allocated" without being zeroed, which could cause a
1 Bus Error crash if 1) a key pressed matched the "key code" in the "key macro" and 2) the "key macro" also had a "pointer"
"macro" to execute which contained an odd address. You might also have gotten "lucky" and execute the "macro" residing at,
address 0.

* The CopyPaste utility now works with dataComet, which now copies the TextEdit Scrap to the Application Scrap with every cut or
copy. "Copy" commands used in QuickKeys macros should also now work correctly. You can turn this off if you like using the
"Control Global..." option "Zero Scrap" if you wish to conserve memory. In addition, the scrap is no longer "lost" if you "pass
through" dataComet with a TEXT scrap in either mode (the scrap was being zeroed on entry but was not being updated on exit unless
it had been modified).

___________________________________________________
4.43B7
9/3/97
___________________________________________________
Attempted Bug fixes:
* The startup code sequence was changed somewhat in an attempt to remedy mysterious crashing problems with 4.43B6 (evidently
caused by the key macro bug noted above, fixed in 4.43B8).

___________________________________________________
4.43B6
9/1/97
___________________________________________________
Features:
* NEW HELP FEATURE! "Control-Command-Key", "Control-Mouse Click", or "Control-Menu Select" will automatically open the relevant
dataComet documentation and search for the menu name, button name, or dialog text item selected.
* INTERNATIONALIZATION: dataComet 4.43B6 stores all string resources in Macintosh resources so they can be readily translated
into languages other than English; see "A5. Internationalizing dC" for more information.
* SOCKS:

The "Configure Session..." dialog now allows you to specify a SOCKS V4 proxy for Telnet/TN3270 connections.

* MODELESS DIALOGS: All dialogs except "Configure Session" have been made modeless, including the "Control Color..." and
"Define Macro..." dialogs! Setting colors is now much easier than in previous versions of dataComet.
* You can now set global key macros and menu macros using the "Define Macro..." dialog; these macros are saved in the "Comet
Default" document, and work in all windows. Macros defined for a particular window will supersede the global macros.
* You can now add user-defined macros to the "Macros" menu as named menu items.
* "Command-Mouse Click" in emulator windows will now select a word and resolve it as a URL through Internet Config; note you
MUST install ICeTEe to support this feature.
* "Control-Mouse Click" in emulator windows will now perform an IBM light pen selection, or if that's not appropriate, perform a
"copy word/paste/CR" operation (which works very well with host application command interfaces that expect words as commands and
list them separately on-screen!).
* Translation of "foreign" characters using standard Mac keyboard layouts now works correctly when using either the Comet-Fonts
or standard Macintosh fonts. Selecting a new font automatically selects the correct option for "Translation"; you can translate
from the Macintosh character set to a session's selected character set by using "Shift-Paste". Using the Enter key to send text
to a host from an edit window with a Macintosh-native font will cause it to be automatically translated to the target window's
character set.
* Bold fonts are automatically selected when a font is selected using the "Font ->" submenu; if no font named "<Fontname> Bold"
exists, QuickDraw bolding is used with the selected font, using dataComet's automatic character cell clipping, which will draw
more slowly, but will allow the use of any font. You can still select alternate bold fonts manually using the "Bold Font ->"
submenu.
* New macros:
"!AS" performs an IBM light pen operation on the field at the mouse position;
"!As" performs an IBM light pen operation on the field at the cursor position.
"!CV" and "!Cv" allow you to control the VT100 auto-print mode locally.

"!Eg" go to mouse location for replacing single click.
"!FD" now prints the selection using Serial Printing;
"!Fd" now does a form feed.
"!WA" opens items in the Apple menu by name.
The "Define Macro..." modeless dialog now allows you to enter menu items directly from the menus using the mouse while you are
editing a macro.
* The "Control Global" dialog now include two new options, "Open "Comet Default" on launch" and "Clear scrollback buffers
automatically".
* The "Control Printing..." dialog now allows you to select Serial Printing as a global default, and also set the page length,
top offset in lines, and right margin in characters for serial printing. Serial printing now also adds page numbers.
* "Shift-Option-Page Up" now automatically deletes all spaces and tabs in the selected text of an edit window.
* "Shift-Option-Page Down" now inserts '>' characters in the selected text of an edit window.
* "Option-Add Returns" (Option-/) now allows you to set edit windows so that TextEdit's automatic line-wrapping is turned off;
the text is shifted automatically so that the cursor will be visible as you move through the text (there is however still no
horizontal scrollbar). This makes the edit windows much more useful for editing scripts.
* The text selection is now preserved after an edit window is closed, so that the selection appears in the same place when it is
re-opened.
* The IBM 3278 emulator now indicates insert mode by changing the cursor to a vertical bar, and indicates the "X SYSTEM" wait
state by swapping between a block and underline cursor (using the opposite of your preference), rather than displaying "HOST
BUSY" in the control bar.
* Registered versions of dataComet can have a graphic displayed rather than the standard splash screen (this graphic is stored
as the 'PICT' 128 resource in the application; it will be displayed in the window 'WIND' 128 if it is defined, in 'WIND' 0 if it
is not).
Bug Fixes:
* VT100 background and foreground colors are now set correctly when a single character is drawn.
* The DEC-Multinational font now includes a 16 point font; the 16 point Bold fonts for DEC-Multinational Bold and ISO-Latin-1
Bold now have international characters properly bolded.
* Serial printing wraps edit window text correctly, and inserts three spaces for each Tab character.
* The print page count is no longer automatically reset whenever a new print is performed; "Shift-Print Page Now" allows you to
reset the page number without causing page eject.
* TFTP uploads now work correctly; large uploads crashed due to the failure of some *very* old PC/IP code to allocate a large
enough buffer.
* The stack size has been increased from 40K to 64K to help avoid situations where the stack overwrites the Macintosh heap
(which contains the application's code and data, so this can be very bad!). This sometimes causes an ID=28 error when it occurs;
note that the "Stack Sniffer" which generates an ID=28 error only checks for heap collisions every 1/60 second, so heap
collisions can occur without being detected.
_____________________________________________________________________________
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dataComet documentation (Rev. 5/6/00):
Copyright 1995, 1996 databeast, Inc. All Rights Reserved.
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4.43B4
4.41

4.43B3
4.40

4.43B2

4.43B

___________________________________________________
4.43B5
12/14/96
___________________________________________________
Bug Fixes:
* The cursor no longer disappears when paging in the emulator window and Fast Drawing is on.
* The 3270 PF Shift state is no longer set incorrectly when the PF key is entered with NO Shift after ordinary characters are
entered with the Shift key down.
* IBM 3270 sessions will no longer lock in "HOST BUSY" mode (requiring an IBM "Reset" menu command to continue) when a Telnet
Timing Mark is received (some implementations of TCP/IP on IBM mainframes use this as a session keepalive, so this would occur
after a session had been left idle about 10 minutes). (This problem was introduced with the addition of 3270 -> ASCII fallback
mode in 4.43B4.)
* ASCII emulator sessions will now present VT graphics characters even when the selected font does not contain them (e.g., PCANSI or other Mac fonts). Support for VT300 mode character set selection control sequences has been added so that alternate
character sets will be displayed correctly (LS1R, LS2, LS2R, LS3, SS2, SS3).
* You can now enter ^M (using Control-M) to enter CR in dialog text items without the dialog automatically taking the Control-M
as an return meaning "OK".
* You can now paste into dialog items using the menu item as well as the menu item key equivalent.
* If "Use Command Font" is not checked in the Macro dialogs, buttons will produce the correct macro strings rather than "junk"
characters (which map into symbols in the "Comet-Chicago" font. If "Use Command Font" is checked and the "Comet-Chicago" font
has not been installed in the Fonts folder, the user is prompted to install the font when the Macro dialog appears.
* The IBM 3270 emulator will no longer report an error when an empty selection is pasted.
* The "Copy Screen" option in the "Control Global..." dialog is now OFF by default so that executing a macro which performs a
click-word-copy-paste won't yield huge amounts of screen junk when you click on a blank and get a zero-length selection.

___________________________________________________
4.43B4
11/12/96
___________________________________________________
Features:
* Added a "Do Blink" item to the "Control ASCII Emulator..." dialog, which allows you to disable blinking.
* The default application size has been increased to 1.5MB from 1MB to make more space available for text documents and multiple
sessions with scrollback buffers. This is for the sake of overall usability; dataComet can still run in 600K.
* The PC-ANSI font now includes the a 12-point font; in addition, the PC-ANSI special graphics characters have been added to the
fonts (e.g., Carriage Returns appear as musical note symbols!).
* The ISO-Latin-1 font now includes a 16-point font.
Bug Fixes:

* The "Control Global" dialog option "Quit automatically when all windows closed" now works correctly with unregistered copies.
* The VT220 function keys at the top of the extended keyboard are now mapped by default so that F1 -> F1, F2 -> F2, ..., F15 ->
F15, Shift-F1 -> F13, Shift-F2 -> F14, ..., Shift-F8 -> F20, rather than the old ("NCSA standard") mapping with F1 -> F6, etc.,
in order to avoid needless confusion and mystification.
* The Clipboard is now updated properly after copying from an emulator screen and switching to another application. (dataComet
was failing to perform a SystemEdit() call when an emulator screen copies was performed, so sometimes MultiFinder failed to note
that the System Clipboard needed to be updated.)
* The AppleScript dataComet "copy" command now waits for up to 45 seconds for dataComet macros executing in the frontmost
session to be completed before copying the window selection to try to guarantee that select/copy macro scripts will work
smoothly. NOTE that during this wait your whole system will have to wait for the loop to complete; if you're using a complicated
macro to display and select text, it's best to check whether the "status" of a session contains "Executing" before performing a
copy; this way you can be absolutely certain that complex selection macros will copy the selection you really want.

* The Telnet "Local Echo" command should now always provide local display; ASCII Telnet sessions now ignore a WILL ECHO when
this is selected and perform Local Echo anyway (sessions with Lexis failed to display characters because the host was responding
WILL ECHO when sent the DON'T ECHO, subverting the negotiation process).
* Default ASCII character translation tables are now reset to avoid junk characters appearing after dropping back into VT100
from 3270 mode.
* PC-ANSI and VT220 ANSI host color mapping has been fixed so that the background color is set correctly.
Reversed fields are
now reversed correctly when host color mapping is on. The default ANSI color maps have been improved so that they are more
legible and display correctly in 16-color Monitor mode.
* Two macro commands were added to allow more flexible color mapping for those who use multiple monitors ("!Ck" guarantees the
best color match available on the current display--see "A0. Problem Solving"; "!CK" uses the best match on the main monitor, the
default).
* VT100 printing now passes Escape sequences (other than End Print Mode) along to the printer rather than discarding them.
VT100 print mode is now reset when a session is reset (Shift-Clear Buffer) or closed so that the session will not remain stuck in
Print mode if the host fails to turn it off.
* Scrolling in edit windows now scrolls smoothly rather than jumping by half pages to be more typically Macish. Using "ShiftCursor Down" or "Shift-Cursor Right" to extend the text selection in an edit window now scrolls when it passes the bottom of the
window rather than remaining fixed.

___________________________________________________
4.43B3
9/3/96
___________________________________________________
Features:
* Option-Copy now performs a "Copy Table" command, so it is no longer necessary to toggle the Table mode.
now used to set the contents of the Clipboard to a string.)

(Shift-Option-Copy is

* NOTE that the pressing the Enter key in a text window now automatically sends text to the next frontmost emulator window
(holding down the Option key is no longer required; this makes text windows work just like a session's .edit window).
Bug Fixes:
* IBM 3270 screens now draw correctly when using fonts other than the Comet fonts. Attribute bytes which corresponded to zero
width characters in other fonts (e.g., Character 0 in the Monaco font) were being interpreted as diacritics, so that an
additional space was added after the attribute at the beginning of a 3270 field.
* Pressing Shift-F1 through Shift-F15 when using the 3270 emulator on an extended keyboard now sends a PF key shifted up by 12.
* VT100 stream printing now maintains the page count properly.
* If you copy a selection in a dialog it will now always be copied to the Clipboard when you switch applications (this was not
occurring if only the dialog item had been copied).
* Serial connections no longer execute the connection macro twice if the Session option "Open session without terminal type
negotiation" is turned on.
* If Domain Name resolution takes longer than three seconds, a window now informs you that you're "Waiting for MacTCP to resolve
domain name...".
* Selecting the "Log session in..." menu item to turn off logging now causes the current screen to be appended to the log.

* The Font selected for printing (using Shift-Font) is now saved in the session document.
* Scrolling delays when paging have again been adjusted for optimal usability.
___________________________________________________
4.43B2
8/20/96
___________________________________________________
Bug Fixes:
* The "!CB" shield window macro (used with kiosk applications) now works correctly when placed in the "Application Launch"
macro. The "Macro" menu "Set Launch macro..." is now named "Set dataComet Launch macro..." to avoid ambiguity.
* TN3270 sessions now revert to ASCII line mode whenever the Telnet options governing TN3270 now longer apply.
sessions made through an SNS/TCP linemode connection to go into 3278 mode and then fall back correctly.

This allows

* The "Window" menu item "Close window" no longer waits for the session to completely close before returning control to the
user. This could result in delays if the host failed to close a session promptly.
* Selections >32K in size are no longer truncated when you switch to another application. The selection is also now inverted
correctly when a selection is made; sometimes "Select all" would fail to invert the screen in windows with more than 2000 lines.
* Scrolling by lines when extending a selection in an ASCII emulator window now scrolls as fast as possible rather than having a
delay if paging had taken place.
___________________________________________________
4.43B
7/31/96
___________________________________________________
Features:
* The splash screen now defaults to a 5-second additional delay for unregistered copies rather than 25 to address complaints
about the splash screen. To remind users that registration is required, unregistered copies of dataComet now automatically
allocate the first window slot to the "About dataComet" window, which cannot be altered or closed. Registering dataComet will
free this window slot.
* MacTCP is now configured to poll MacTCP for new data rather than waiting for it to upcall. This may provide better
interactive performance in situations where some MacTCP Extensions deliver "sluggish" performance with the asynchronous MacTCP
Read calls which dataComet has used in the past. You can turn on the asynchronous call interface by turning off the "Control
Global..." "Poll" dialog item (under "MacTCP/OT bug workarounds").
* The Macintosh cursor in the emulator window is now a standard Macintosh text cursor by default, in order to achieve a more
consistent Macintosh look-and-feel. You can select the underscore cursor by turning off the "Control Global..." dialog item "Use
text cursor only".
* The window title is enclosed in parentheses to indicate that a session is closed.
* You can select by whole lines in the emulator window by holding the Option key down while making the selection.
* "Option-New" now clones the topmost document and opens it.
* Character translation tables are now supported (with the same format as NCSA's); a "Translation" sub-menu has been added to
the "Control" menu to allow selection of the tables.
* You can now select VT100 National replacement character (NRC) mapping for ISO-Latin-1 or Macintosh character sets (e.g.,
Monaco) by using a macro.
* All ASCII emulators now have an option to let the host select ANSI color mapping; the option is set using the "Use host color"
item in the "Control Color..." dialog. A "Default" button has been also been added to the "Control Color..." dialog.
* Font width/leading control: you can now set the font width and leading (additional spacing for each line) using the Control
menu "Leading" and "Width" submenus. This allows you to control the width and height of proportional fonts, and to make fixed
width fonts more compact or more legible (with considerably slower drawing speed).
* Print font/size control: you can now select the font and font size used for printing by holding down the Shift key while
selecting the Control menu items "Font" and "Size". A '>' character indicates the selected print font and size.
* Printed text in edit windows is now aligned correctly when a fixed-width font is used on a LaserWriter.
* "Show 'Print...' dialog when printing host print streams" has been added to the "Control Print..." dialog to control
presentation of the Macintosh Print Dialog when QuickDraw printing is selected and the host prints using VT100 print streams.

This is now enabled by default.
* You can now save VT100 print streams to a file by holding down the Shift key while selecting the "Open Log..." menu item.
* You can now set the ASCII emulators to allow an ASCII Backspace to wrap back and up one line using the "Control Emulator..."
dialog item "BS wraps".
* A '!qa' macro allows you to put up an alert or 25th line notice.
Bug Fixes:
*** IMPORTANT FIX: When a dataComet document with a higher version number for the configuration data is launched, dataComet
4.42 erroneously puts up an error message stating "Your document is damaged, using default" and ignores the document. This has
been fixed in 4.43.
Note that this will require that users upgrade to 4.43 to obtain configuration settings from 4.43 documents, so site licensees
who redistribute documents need to make them using 4.42 or update users to 4.43; sorry for the inconvenience.
* A failure to reset a timer properly has been corrected; this could cause an infinite loop if a wait for a match succeeded in a
very brief interval after the time elapsed but before the timer was reset.
* "Execute Selection" in the Selection menu now executes properly rather than being ignored when a macro is executed (using
Shift-Enter).
* Several macros have been fixed to use the current context rather than the front window's context when executing so that they
will execute reliably when a window is not frontmost. This affected scripted menu execution and the selection macros.
* Telnet socket specifications using spaces or colons now work correctly with decimal addresses (e.g., "123.88.22.1:23"
"123.88.22.1 23"). The IP address in the "Telnet" menu is now updated properly when the address is changed.

or

* The Session menu "Abort..." command is now enabled when a session has been opened but a connection has not yet been made.
* The ASCII emulators now cancel any current escape sequence and start a new escape sequence when an <ESC> character is
received. This resulted (fairly rarely) in confused displays, particularly unexecuted escape sequences which would appear at
unexpected places on the display (e.g., "[23;1H").
* The ANSI default color mapping for background intense colors is now the same as the background normal colors so that ANSI
displays are more legible. (The background intense color settings are still set separately.)
* The "VT220 keys sent without shift down" item has been added to the "Control Keypad" dialog when IBM keymapping mode is used
with the VT100/220 emulator.
* The beep should no longer sound improperly (as if new data had been received) when dataComet is in the background and a
session is iconified.
* Fonts: ^G has been added to the fonts from which it was missing. The ISO Latin-1 font has been fixed so that the "^o"
character appears as a "caret-o" rather than being cut off at the top so it appeared to be an umlaut.
* The "Control Global..." configuration items are now updated correctly when dataComet is quit in all instances; they were not
being updated if dataComet quit automatically as a result of a window close.
* WaitNextEvent() is now called while the splash screen is displayed so the clock and other applications will get background
cycles.
* Selecting a window in the "Window" menu no longer toggles between the emulator and edit windows to avoid confusion when
executing macros.
* Paging now pauses after the first page ONLY rather than waiting 1/3 second per screen as in 4.42.
* A beep now sounds when a key is pressed in an emulator window and the connection is not open.
* The zoomed page width is now set to 540 pixels rather than 580 so that a printed copy of a zoomed page fits properly on the
printed page.
* The scrollbar in a .edit window is now deactivated correctly when the window is zoomed automatically on a document launch.
The scrollbar in an emulator window is now reset correctly when a "Clear buffer" command is used.

___________________________________________________
4.42
5/19/96
___________________________________________________
Features:

* Triggers: The '!z\255' match case macro can now be used to configure triggers for use with MUDS and other applications by
terminating the cases with '!Z\001'. See the document on "Macros".
* You can now add buttons to the top button bar by holding down the Option key while clicking the mouse in the shaded area.
You can disable a button by Option-clicking on it and setting the Title to an empty string. Up to 24 buttons can be configured
in the button bar.
* Paging in windows is now limited to 3 pages per second to make it easier to scan the pages as they pass.
applies when the mouse is used; menu paging goes as fast as possible.

This limit only

* Edit windows now page rather than just scrolling when the mouse is pulled far up (or down) when performing a mouse-down and
drag to select text, so this functions the same as it does with the emulator windows.
* Option-Clicking in an emulator window now resets the selection range.
* An option has been added to the "Set keypad..." dialog which allows the 6 VT220 keys to be sent without holding down the Shift
key (and the Shift key produces the default Apple GUI behavior, e.g., "Page up").
* Holding down the Shift key while selecting the Edit menu item "Record Session" now performs literal session logging into the
sessions's .edit window for debugging applications (like the "!CL" macro).
* The 3270 emulation performs automatic paging when you use Paste or Command-Enter so you can paste whole documents rather than
only a single page of text, e.g., when using INPUT mode with XEDIT. An Enter is performed whenever the cursor wraps to the top.
(Note that you will still need to "Add Returns" to make sure that TextEdit text is wrapped before pasting).
* The "Log erase" option was added to the "Control Emulator (ASCII)" dialog to allow partially erased lines to be logged in the
scrollback buffer.
Bug Fixes:
* Selecting the terminal type no longer causes a crash (this was introduced in 4.41).
* NOTE: the "Close Window" and "Close Session" command-key equivalents have been switched so that "Close Window" uses the
standard Command-W rather than Command-\.
* A case where switching VT100 screen sizes from 80 to 132 columns could cause a crash when using fast drawing has been fixed.
* VT100 and H19 (VT52) scrollback buffering now includes all lines which are deleted using the 'J' "Erase in Display" commands
when only part of the screen is erased. This enhances performance with paging in PINE.
* The IBM 3270 Erase All Unprotected command now erases all fields rather than just one field. The "Erase Input" command works
correctly again, and now also repositions the cursor to the beginning of the current field after erasing it. "Option-Erase
Input" erases ALL unprotected characters on the display.
* Mouse clicks in the emulator window no longer select a character when the mouse moves very slightly (this occurred at the edge
of a character cell).
* The default setting for mapping Escape to '`' is now off.
Session" macro is now 0 (limited only by memory available).

The default setting for Scrollback buffering in the "Control

* Delete characters sent by ASCII hosts are ignored.
* All telnet sessions now try to negotiate Telnet window size when a connection is made.
* Setting "8-bit characters" in the Telnet menu no longer causes Telnet binary mode to be negotiated with the host. This caused
confusing results with some hosts. NOTE that UNIX hosts will now need to be configured to pass 8-bit characters (see the
document on "Emulators").
* Quickdraw printing routines now call the Close routines even when the Open routines fail to guarantee that all memory
associated with a print call is released in the event of a failure.
* QuickDraw printing routines now print "reverse" emulator fields correctly rather than leaving them blank on an ImageWriter.
* Serial printing now wraps the lines correctly when "Print Screen" is executed in an emulator window without a selection.
* Serial printing now avoids a condition where the Printer port was erroneously found to be busy, leading to a dialog to close
the existing *network* connection. Closing the connection at this point would close a Telnet connection.
* dataComet no longer presents an error message stating "No serial configuration update" the first time it is launched on a
machine.
* To help guarantee international menu key compatibility both words of the KeyTrans() result are checked.

* The menu items for Cut, Copy, and Paste now work correctly with the "Set key macro..." and "Set macro..." dialogs when they
are selected from the menu as well as when executed via a Command-X, Command-C, or Command-V.

___________________________________________________
4.41 -- please upgrade to this version! 4/2/96
___________________________________________________
Features:
* dataComet now supports AppleScript!

See the document on AppleScript for more information.

* You can now send meta-characters using "Control-(Shift-Option)" key combinations.
* Added text window commands: "Option-Copy", which queries the user for text with which to set the clipboard, "Option-Paste",
which does a search before pasting ("Repeat Paste"), and "Option-Shift-Paste", which does a "Replace all" operation.
* The "Macros" menu command "Shift-Record" records a session without generating match strings, which don't work well with fixedscreen formats (e.g. IBM 3270 displays).
* Scrolling is now turned off automatically after one error alert that there's not enough memory available to append text to the
buffer; this avoids multiple error alerts.
* The ASCII "!CL" show literal mode now also logs in the .edit window the characters sent to the host by the user (as does the
IBM literal mode). The .edit window now automatically deletes the text at its top when it runs out of space to add and literal
mode is in use, so that debugging host interactions using literal mode is easier.
Bug Fixes:
*** IMPORTANT FIX: MacTCP sessions closed by the host now terminate properly. The bug (introduced in 4.40) caused sessions
reopened after a host close (e.g., from a "logout" command) to report "MacTCP: I/O in progress"; further attempts to open the
session would cause a crash.
*** IMPORTANT FIX: Option key handling now uses the standard Mac keyboard layout properly in emulator windows; the IBM PF keys
are now sent using Control-key combinations. The "Control Global..." item "Remap Option-key combinations" is now OFF by default
for better international compatibility.
* dataComet-NCSA and dataComet-Brown now launch documents correctly when the "Comet Default" document does not exist (e.g., it
has not yet been created).
* The "Comet Default" settings document is now closed after use (even when "Comet Default"'s "Only one session per documet"
setting is on in the "Control Session..." dialog). A bug was fixed which could lead to a crash if the "Comet Default" was open
and a new session was created and then disposed of.
* Background window switches now activate the new front window correctly.
* Background emulator screen updates now occur promptly while dataComet is waiting to be switched into the foreground to present
an error alert rather than being delayed until after the switch.
* Background Copy and Paste now works correctly (dataComet was using the application scrap and GetScrap(), which are unreliable
in the background).
* Timers are now allocated in the System Heap so they are updated properly when dataComet is running in the background.
* Control key interpretation is now handled through the Script Manager when it is available in order to handle varying keyboard
layouts correctly (e.g., a Dvorak layout).
* The "ins", "home", "end", "del (x->)", "page up", and "page down" keys now work when an emulator window is frontmost. To send
VT220 keys, hold down the Shift key while pressing the key.
* The IBM 3270 emulator now always sends an "Enter" when the Return key is pressed; it no longer remaps the Return key to "Line
Feed" when the ASCII mode "Control Emulator" "Return key sends" item "LF" is on. This is dataComet's default setting, so the IBM
"Enter" key could be sent only by pressing the Enter key or remapping the Return key. Shift-Return still performs a "Line Feed".
* The IBM Reset key is now handled immediately so that the "Host Busy" condition can be reset (rather than having the Reset wait
forever on the macro queue for the Busy condition to clear).
* Text window output is now redirected correctly when the "Shift-Window Select" redirection command (or "!W>" macro) is used so
that edit windows can be more easily used as sources for boiler-plate text (i.e., you need only press Enter to paste the
selection into the session with which it's associated).
* The default IBM 3270 and PC-ANSI color mappings have been updated to be more attractive.

* The "Window" menu "Reconfigure Session..." dialog now resets the terminal when OK'ed so that you do not need to reconnect to
get the terminal type set correctly.
* All VT100 Erase in Display commands now reset double high and wide character attributes.
* The "CometChicagoFont" is now accessed by name rather than number to avoid font ID conflicts.
* The DEC-Multinational and ISO-Latin fonts have been improved.
incorrect characters have been fixed.

Both now have 9 and 12 point sizes and a bold font, and some

___________________________________________________
4.40
3/13/96
___________________________________________________
Enhancements:
* The "Serial" menu now offers the choice of 115K and 230K connection speeds.
* Holding down the option key when opening a session document opens the document without opening the connection rather than
presenting the "Configure Session" dialog. You can now use a new "Control Session" dialog item, "Connect automatically", to
configure a document so that you can open it without connecting.
* You can use dataComet-NCSA or dataComet-Brown Sets to launch sets of dataComet documents.
See the "Telnet Set example" and "Brown Set example" in the Documents menu.
* You can now reset the emulator using the "Shift-Clear buffer" menu command. This also resets all vt100 graphics characters
displayed, the better to fix displays which have been messed up by an inappropriate SO control character in the data stream.
* The "Control Session" item "Only one session per document" is now on by default, so that the default behavior is more useful
when launching from browsers or Sets.
Bug fixes:
*** IMPORTANT FIX: ALL previous versions of Comet and dataComet have been found to crash the system when the Macintosh Segment
Loader attempts to launch the application and there is less memory available than the application's "Preferred" size. This
problem has been resolved by correcting the link order of libraries when dataComet is linked, so that the entry point of the
program is at offset 0, and the Segment Loader loads the application code correctly when memory is short. PLEASE AVOID this
problem by upgrading to dataComet 4.40, dataComet-Brown 4.40, and dataComet-NCSA 4.40!
*** IMPORTANT FIX: The error dialog is now fixed so it is pre-loaded and locked and uses ICON resources from dataComet's
resource fork rather than relying on their presence in the System. This avoids crashes caused when the dialog executed at a time
when either dataComet's memory or Finder memory was low. (This bug was also present in Comet.)
*** IMPORTANT FIX:
resources.

Memory leaks of >6K per session disposed of have been avoided by properly disposing of all session

*** IMPORTANT FIX: All calls to the Print Manager are made AFTER PrOpen() is called, so that the default is set correctly and
you are notified if your printer has changed. Improved error checking handles Print Manager failure modes correctly.
*** IMPORTANT FIX: The serial driver code now tests the serial port to see if it's in use before opening a connection, and
queries the user whether to proceed if it's already open, and no longer hangs up the line when the application quits if the
serial driver has been opened. This prevents MacTCP connection loss when using MacSLIP or interfering with other application
which use the serial ports.
* The "Serial" menu items "Hang up phone" and "Reset Parameter RAM" are now executed correctly when they are selected.
* dataComet now works better under System 6. Menu keys work correctly even when the Script Manager is not present; the
scrollbars are drawn properly rather than reversed when using the scrollbar in the emulator window.
* Document opens now fail with an alert if the whole text can't be opened.
enough memory to load the .edit window in its entirety.

Session documents are not opened unless there is

* Edit windows now have the scrollbars set so that the cursor will display if it is on an empty line at the end of the text.
This also guarantees that the scrollbars will appear when text is appended to an empty window and the text is scrolled halfway
down.
* The document icon mask has been fixed so it inverts correctly when selected.
* The VT100 and ANSI emulators now handle up to 64 parameters in a command sequence rather than only 10.
incorrect attribute display and other non-fatal errors.

This could cause

* The mouse click code now delays handling of keyboard input until the click action is completed so that keyed text appears
where you clicked.

* The "home", "end", "x->", "page up", and "page down" keys now work when an edit window is frontmost. The "help" key performs
a "Find selection" command. If the emulator window is up, these keys still send VT220 escape sequences to help ensure
compatibility with host applications.
* The VT100 "Calculator" keypad mode now sends a '+' when the '+' key is pressed rather than an "Application" mode control
sequence.
_____________________________________________________________________________

A1.5. dataComet Release Notes 4.1.2A - 4.30
_____________________________________________________________________________
dataComet documentation (Rev. 5/6/00):
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This document has information on (select and use "Find..." to go to the
section):
Release Notes:
4.30
4.1.9A
4.1.5A

4.22B
4.1.8A
4.1.4A

4.2.1B
4.1.7A
4.1.3A

4.2.0B
4.1.6A
4.1.2A

___________________________________________________
4.30
2/24/96
___________________________________________________
Features:
* dataComet now prompts the user to save or allow automatic deletion of a new dataComet document produced by dataComet-NCSA 4.30
or dataComet-Brown 4.30 (when those applications are configured to do so). For best performance of dataComet as a Telnet/TN3270
helper application, you should use these three applications at version 4.30 or higher; dataComet-NCSA and dataComet-Brown 4.30
have significant enhancements in their reliability and functionality over earlier versions.
See "Network helper and GURL
AppleEvent support" in the "Overview of dataComet" document.
* There is now a "Match case" macro; there are also new macros to control Return key mapping for the ASCII emulators (see "Match
case" and "Telnet commands" in the document on Macros).
* The "Control Printing..." dialog now has an option to enable Color printing using the emulator's color map; dataComet now
defaults to printing emulator screens in black and white to avoid color mapping problems.
Bug fixes:
* Sessions opened through GURL AppleEvents now have the name set to the host name rather than '@'.
* The cursor is now set properly when WindowShade is used to hide a dataComet window.
* Several memory leaks which could affect usability in low memory conditions were fixed.
* You can now define key macros for a new edit window without causing a crash. You can also now save the configuration for a
text-only document.
* Edit windows now check for exactly 32767 characters rather than 32500 so they can display as much text as TextEdit can handle.
* Each edit window now has a separate scrap; an Undo of a Cut or Undo operation now restores the text that was cut from the
window rather than the current scrap.
* Setting the Modem Port as the Serial Printing port in the "Control Printing..." dialog now selects the Modem port when the
document is reopened rather than incorrectly opening the Printer Port.
* Printing a page in the scrollback buffer prints correctly rather than showing

incorrect bold, inverse, and other attributes.

* Pastes with both the ASCII and IBM emulators work more reliably; using the Enter key to paste into a 3270 session now works;
ASCII pastes now work when delays are set.
* You can now use the Window menu items when a session is Miniaturized (iconified).
* Labels now appear in the correct place in the popup list when there are empty labels preceding them.
cursor-button now displays the labels when "Show status bar at top of window" is disabled.
* When the MacTCP Domain Name Resolver returns 0 or -1 for an address, an
* The "Set macro" dialogs now use the "Use Command Font" setting correctly;
were not being displayed correctly.
___________________________________________________

Pressing the '?'

alert is presented.
when it was off, macro actions such as PF entries

4.22B
1/15/96
___________________________________________________

Features:
* You can now define key macros for text-only windows.
* The Edit Selection menu item "Go to line..." now sets the cursor at the beginning of the line in edit windows.
* You can now copy and paste the color array from one "Control Color..." dialog panel into another session's "Control Color..."
dialog panel.
* 16-color ANSI is now supported; hold down the Shift key when selecting the Control Color... dialog to set the Intense colors.
* Documents: A new fedworld.gov Document provides a sample PC-ANSI
a better example of configuring dataComet for card catalog access.
user can select items using only the mouse.

configuration. The ALA sample has been enhanced to provide
E.g., the single click now performs a copy/paste so the

Bug fixes:
* PC-ANSI color displays now display properly (the default background color is now white rather than the same as the foreground
in the default case!).
* IBM screens no longer display "square boxes" instead of blanks when used with Monaco and some other fonts which use a "square
box" as character 255, which dataComet is using to represent 3270 NULL characters.
* Text is now always properly updated in edit windows after a "Find..." is performed. When the cursor moves outside the window,
the selection is now displayed at the middle of the window rather than the top or bottom so that scrolling is easier to use.
* Text window contents no longer "flicker" due to being drawn twice when

a document is opened.

* Telnet Terminal type negotiation has been fixed so that sessions with OpenVMS (and MultiNet) TCP/IP servers will open even
though they perform incomplete negotiations (i.e., the negotiation sequence is not terminated by actual data transmission to fix
the type: this can cause problems if the host expects a wholly different character set such as IBM EBCDIC). Keying is allowed
when one second has elapsed since the last negotiation.
* An incorrect alert stating "Can't delete macro resource" no longer appears when setting macros.
* The single click macro or default cursor motion action is not executed
response down somewhat.)

if a double-click is performed.

(Note this slows

___________________________________________________
4.2.1B
12/18/95
___________________________________________________
Features:
* You can now perform a "Power Quit" (using Option-Quit) which closes dataComet without prompts to close windows or save
documents.
* You can now set the Option key to function as a meta-key for EMACS using the Control menu "Emulator" item "Option is MetaKey".
* The IBM 3270 PF/Action and ASCII Control key menus now stay up when an edit window is frontmost; in this case, these menus
produce only a beep unless the Option key is held down, which causes the equivalent macro to be placed in the edit window at the
cursor.
* The Option key NO LONGER automatically produces Control characters except on Macs using Mac+ or previous keyboards, which lack
a Control key. This allows the entry of standard Option-key characters (e.g., umlaut-U) in edit windows for better compatibility
with the Keycaps
* dataComet now sets the default creator type for downloaded 'TEXT' files to dataComet rather than TeachText.
* The '!CB' shieldwindow macro command, which puts up a window to conceal the Finder and other applications, has been added to
provide security when dataComet is used in a public kiosk. (See "Set Launch Macro" above).
Bug fixes:
* The MacTCP DNR code is no longer closed, released, and then called again without being properly opened (this very nasty bug
has been present in all previous versions of dataComet; under some circumstances it could cause dataComet to crash and leave a
damaged MacTCP file).

* dataComet now updates window positions and fonts when a Quit is done.
using the File menu "Close" command.

This formerly occurred only if the window was closed

* The IBM 3270 Action menu has been corrected so that the defined key-equivalents work with all 3270 keypad configurations.
___________________________________________________
4.2.0B
12/14/95
___________________________________________________
Features:
* The Option key can now be set to function as a meta key in the "Control Emulator" dialog.
* If a selection is made in an edit window, "Print..." will print the selection rather than the complete text in the window.
(The "!Fq" macro was added also to support this function.)
* Support has been added for disabling menu items, including the Finder menu (See "Menu Commands" in the document on "Macros").
Used with the "NoForceQuit" extension installed in the System Extensions and a dataComet "Set Launch Macro" which disables the
menus, you can now set up a secure terminal kiosk for public access using dataComet. (And remember, with customizable macro
buttons one can now set up a preconfigured document to simplify access for inexperienced users...).
* Key Macros can now be defined in edit-only windows.
* Fonts: A Comet-DEC-Multinational font is now provided in the dataComet release package.
the box characters align better and a 16-point version is now included.

The PC-ANSI font has been fixed so

Bug fixes:
* If serial printing is on and the serial port can't be opened, the copy of the data to be printed is released to avoid an
endless loop.
* The 3270 emulator now draws the screen correctly when inserting characters and performing "Erase field" commands.
* Choosing the "File" menu item "Print page now" when using serial printing causes a form feed to be sent to the printer.
* Edit windows now zoom correctly.
* Type 4 (Zero Divide) system crashes caused by launching old Comet documents and documents made by dataComet-NCSA are now
avoided. The PrDefault() system routine was crashing when it was called without being preceded by a PrOpen() call.
* "Edit -> Selection" items to move the cursor now use the Shift key to extend the selection range and the Option key to move by
words in order to comply better with Macintosh user interface standards.
* The default macro queue size has been upped to 16K from 4K to handle large macros better.
* The documentation on the Search macro has been corrected to accurately describe the macro.
* The Latin-1 character y with an umlaut will now display rather than appearing as a blank.
* Error warnings occurring when an edit window is frontmost are now displayed using a dialog rather than a timed window alert in
order to avoid conditions which can cause crashes.
* Using Option-Select button to set a button macro when the button labels are displayed no longer leaves the screen display
partially blank. (This condition would persist until the window is closed and reopened.)
* Using the "Enter" key to paste from an edit window into an
sending only a portion of it.

emulator window now send the complete selection rather than

___________________________________________________
4.1.9A
11/8/95
___________________________________________________
Bug fixes:
* Version 4.1.8A was burned because the resource fork in the StuffIt archive was bad.
* The 3270 emulator now resets the cursor to 0,0 when the screen is cleared (this affected only the display; the next character
entered appeared in the correct position).

___________________________________________________

4.1.8A
11/4/95
___________________________________________________
Enhancements:
* Copies of dataComet which have been registered can be shared (launched from AppleShare servers by multiple users).
* The execute menu macro ("!\<3-digit menunum>\<3-digit itemnum>") has been extended so that the macro "!\<3-digit menunum>\<<3digit itemnum> + 192>" disables the menu item so that it cannot be used until dataComet is launched again.
* A new "Set Launch Macro..." dialog allows you to set up a macro which is executed on launch, prior to opening any sessions, so
that dataComet can be easily configured to disable various commands. This allows dataComet to serve as a relatively user-proof
kiosk terminal for library or other public access applications.
* Macros were added to select the word and line at the current mouse cursor position, to delay a number of ticks ("!d\000"), and
to send text and execute macros in an edit window ("!El", "!Ew", and "!EM" and "!Em").
* "Command-Enter" and "Command-Return" now send text to the host in a reliable fashion (whereas using the Enter key to execute a
macro in 4.1.7A often resulted in a failure to send plain text due to '!'s in the text or an overrun of the macro buffer).
Shifting these commands causes the text to be interpreted as a macro.
* Menus and default key-equivalents have been rearranged to improve the interface.
by editing the MENU resources in the application.)

(Note that users can modify key-equivalents

* Fonts are now packaged in a separate folder (rather than the application) to save disk space.
opens resource files in the "Fonts" folder.

dataComet now automatically

* dataComet now negotiates sessions successfully with IBM mainframe hosts running SNS-TCP.
* The "Save" command is now executed only if an edit window has been modified.
that it has been modified.

The window's menu item is underlined to indicate

* Output can be redirected from an edit window to a host session by pressing Shift while selecting the target window.
"Summary of special key-action combinations" in the "0. Overview of dataComet" document.

See the

* A "Control ASCII Emulator" dialog item, "Do CR-LF when LF received (newline mode)" has been added.
Bug fixes:
* An icon resource for the '3278' configuration type has been added so that host session document icons are displayed correctly
in the Finder. This also caused some problems with Easy Open.
* Macro recording of menu item selections now works reliably for all menu items.
* The 3270 emulator now handles proportionally-spaced fonts correctly.
* Drawing of selected text in VT100 emulator screens is now performed correctly for characters which have the Reverse attribute
set. As a side effect of this fix, display of selected areas in all emulators is now smooth (no reblanking is performed when
paging).
* Macs with 9" screens no longer automatically go into fast drawing mode; the user must now select this option.
* The "Save Configuration..." dialog now copies all resources from the old session document to the new session document when a
new session name is entered, including macros. Previously one needed to duplicate the document in the Finder to copy the entire
configuration to a new document.
* The "Save" command is now uses different files to save the emulator and .edit window text. This avoids the unpleasant
possibility of overwriting a .edit window by mistake. When the emulator selection is being saved, the menus change so the
"Append" is the default for the "Command-S" Save key equivalent.
* Text-only edit windows can now be miniaturized. If a session is selected in the "Window" menu, whichever window was up front
previously (emualtor or .edit) is brought to the front rather than the emulator window.
* Error messages are reported in a window when an edit window is frontmost.
* The button labels on the left hand side are now drawn only when the emulator window is in front, and the default IBM labels no
longer include ASCII options for buttons numbered above 24.
* Printer port selection has been enabled.
___________________________________________________
4.1.7A
9/14/95
___________________________________________________

Enhancements:
* The "Map Return to Newline" item in the "Control Ascii Emulator" dialog has been replaced by two items are used to set the
mapping, "Return key sends [] CR followed by [] LF". If "Map Return to Newline" was true, it's taken to mean that return -> CR
LF.
Bug fixes:
* MacTCP Read calls now rely on asynchronous completion routines rather than the MacTCP Notification routine. This enhances
performance by replacing the kluge used in 4.1.6A for OT compatibility of occasionally performing a Read (which required 1 second
to complete when no data was available) to catch the cases where the Notification routine failed to report data arrival
correctly.
* The selection scrolls properly now when the top of the buffer scrolls beyond the maximum scrollback buffer limit.
is attempted the selection range is tested for being out of range and an error is reported if it is.

When a copy

* Undo resizes the scroll bars correctly.
* The ASCII emulator drawing routines sometimes left lines blank which should have been drawn if the line was inverted and the
line before it had blanks at the end.
* VT100 character deletion now shifts the on-screen image a double rather than single width when characters are double-wide.
* The VT100 PF4 key now works correctly (it was sometimes mapped to the cursor right key).
* Command-key combinations which don't match menu items are now ignored.
* To prevent confusion and possible mangling of macros, the key macro dialog item "Use Command Font" is disabled while a macro
is being edited.
* The Single-click macro is now interpreted if one has been set.
* Labels for the macro buttons are now updated correctly and saved when the titles are changed.
* The documentation on Macros was incomplete in 4.1.6A; it has now been updated to include more information.
___________________________________________________
4.1.6A
8/31/95
___________________________________________________
Bug fixes:
* Control Global items have been added to control MacTCP status calls and optimization of the MacTCP resend timers.
* dataComet 4.1.6A now works with OT. MacTCP (especially when emulated by OT) intermittently fails to notify applications that
data is available. dataComet used to use MacTCP status calls to check this; it now works around this problem by occasionally
performing a Read without notification. (You can tell when this is happening because of a lag in typing input...)
* Old Comet documents which did not contain a Print Layout resource sometimes crashed when opened.
* The notification window for sessions which have the status bar disabled is now retained between calls to ensure that it will
be there if memory is low. This could cause a crash.
* The labels displayed by the "?" control are now aligned properly.
___________________________________________________
4.1.5A
8/13/95
___________________________________________________
Enhancements:
* "Option-Resize Window" now resizes the emulator screen and negotiates a Window Size (NAWS) Telnet option with Telnet hosts.
* Pasting a sound resource ('snd ') into a dataComet window sets the window's beep to the sound and saves the resource
automatically.
Bug fixes:
* The "Control Emulator" item "Answerback" now sets the Answerback message for ASCII emulators.
* Button macros are now always posted to the correct session when they are executed.

* When text windows are saved, the changed flag is set so that the user is not prompted unnecessarily when quitting dataComet.
* The "!W>windowname\000" macro now works more reliably. Text windows now discard macro keys which can't be sent out on a
connection, so connectionless text windows won't fail to post macros after a macro containing characters for a connection is
executed. (This makes text windows more useful for running macros.)
* Font sizes equal to zero are presumed to need a 9-pt font.
an invalid font size to dataComet-NCSA.)

(Some helper applications produced NCSA documents which passed on

* Windows have a minimum window size enforced so that scrollbars and old Comet documents with bad window sizes will display
correctly.
___________________________________________________
4.1.4A
8/9/95
___________________________________________________
Enhancements:
* Support for GURL AppleEvents has been added.
* The buttons at the top and left of the screen can now be associated with macros by holding down the Option key while clicking
on them.
Bug fixes:
* The screen erase and scroll rectangle is now set correctly when a session is opened with a font size other than 9 pt.
caused seriously muddled screens!
* Menus are now set correctly for the document which is frontmost.
than a session document and vice-versa.

This

Sometimes the menus were set up for a text document rather

* dataComet no longer registers an NBP name on AppleTalk network.
* When a text documents which is already open is opened again, the document is brought to the front rather than being opened
again.
* Text document window positions are now saved correctly.
* Open Transport 1.0.5b4 reports an overlarge maximum segment size on Ethernet which caused dataComet to fail when creating a
session. Sessions will now open even though the segment size is reported incorrectly.
* When new documents are closed, the user is prompted to save them.

___________________________________________________
4.1.3A
7/26/95
___________________________________________________
Bug fixes:
* The "Add page numbers at bottom of page" and "Add line feed after carriage return" were switched in the "Control Printing"
dialog.
* When windows are closed, the corresponding Window menu entry is disabled.
crashes.

Selecting a closed but not-disabled window caused

* When "Show status bar at the top of the window" is disabled, the labels associated with the Macro status rectangle are no
longer displayed. This caused crashes if the window was closed with the go-away box.
* The Telnet Send menu item "Break" now sends a Telnet Break rather than a Telnet Interrupt Process.
* The cursor now blinks in text-only windows.
___________________________________________________
4.1.2A
7/21/95
___________________________________________________
Enhancements:
* Text windows.

Using "New..." or "Open..." with the Shift key held down opens a document as a connectionless text-only

document.

This is a TextEdit document which has a 32K size limit.

* GUI improvements. The Control Controls... dialog allows the user to configure the dataComet emulator window controls to suit
individual preferences. The "About dataComet" menu brings up a text window containing the text. Documentation is contained in
separate text files rather than within the application.
* Selectable Fonts. You can now select fonts other than the dataComet fonts.
proportional fonts as well as fixed point fonts.

ASCII emulators support the display of

* PC-ANSI support with 8 colors.
* VT100 support now includes Print Streaming and the display of blinking and double-width and double-height characters. The
dataComet fonts are automatically switched in for the display of characters > 127 when a different font is in use; this can be
disabled in the Control Emulator dialog. Scrolling through the scrollback buffer is now much faster than it was in Comet.
* If the Control Global dialog item "Enable Fast Drawing" is enabled and a session with the correct font/size is launched with
Color mapping off, dataComet changes the Monitor mode to black-and-white automatically.
* The Control "Printing..." dialog allows the use of non-QuickDraw serial printers which are connected to the Printer Port.
Sessions can be configured to print all text off the top of the page automatically.
* Enhanced text commands. "Undo" is now supported in edit windows, and the Edit menu "Selection" submenu offers commands for
cursor motion, bracket matching, and text quoting.
* Macros: "Record actions for macro" now has a delay built in so that the user no longer has to type slowly for the recording
algorithm to work well. The "Define key macro..." dialog now offers "Ignore Caps Lock" (so that the Caps Lock key is ignored
when matching key macros) and "Use Command Font" (so that the user can use the whole emulator font rather than the special
command font which reinterprets ASCII characters > 127 and uses them as command buttons). "Dump key macros" now formats the
macros in a nicer fashion.
* The "Control Emulator" dialog for the 3270 now offers a new paste option which puts the pasted text into the same starting
position as the first line pasted.
* The "Control Session" dialog now allows you to set the Tab Threshold which is used when copying and the Edit menu item "Table
mode for Copy and Save" is enabled.

Bug fixes:
* The 3270 now handles an EUA command correctly in all cases; this could cause fields not to be erased correctly if the previous
field was protected.
* Failed MacTCP close calls no longer cause crashes.
* MacTCP receive buffers are now allocated to be (4 * MTU + 1K) with a 16K minimum so that dataComet performs better.
* dataComet works on the Macintosh 9500 under Open Transport.
buffers.

For some reason OT failed when dataComet allocated large send

_____________________________________________________________________________

